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Introduction 
 
 
The VSS User Manual is a reference manual that can be used in conjunction with 
the Help pages that accompany each user screen in the VSS application. It provides 
an overview to the VSS Help system as a whole and allows you to refer to and 
compare Help pages easily without moving away from the screen in which you are 
working. 
 
This manual is divided into sections corresponding to the different organizations 
that use the VSS application; the Enterprise Management Center (EMC), Central 
Office (CO), the Voluntary Service stations, and the Games Institutions. 
 
This document supplements the Voluntary Service System Training Guide which 
takes a more task-oriented approach towards understanding the application. 
 
 
Help Pages 
 
Each screen in the VSS application is accompanied by a Help page. The Help page 
provides a general overview of the screen and presents step-by-step instructions for 
performing various tasks using the screen.  
 
You can access the Help pages by clicking on the question-mark icon in the upper 
right corner of each screen. Screen access is limited by the system role you have 
been assigned (user, manager, or administrator) and by the type of site you belong 
to - Central Office (CO), the Enterprise Management Center (EMC), the Games 
station, or a VHA facility station. 
 
 
Help Menus 
 
The Help menu parallels the user screen menu for the entire VSS application. Each 
name in the Help menu is a link to a Help page. The menu appears on the left side 
of each user screen or help page and allows you to navigate to the information you 
want to see or task you want to perform. 
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The full VSS menu includes the following areas of functionality. 
 

• Time Posting - for recording hours of regular and occasional volunteers. 
• Volunteer Records - for viewing and editing Volunteer master records. 
• Reports - for generating reports on various aspects of a station's activities 

and personnel. 
• Awards - for issuing awards to volunteers. 
• Maintenance - for tailoring the VSS application to a site's needs (e.g., 

entering local services, organizations, and programs). 
• User Administration - for viewing and assigning security roles to system 

users. 
• Donations - for tracking donations to a VHA facility. 
• Games - for administering the VHA annual National Veterans Games 

program. 
 
The menu items appear as folder (VSS menu) or book (Help menu) icons. By 
clicking on the plus sign to the left of an icon, you can see the names of the user 
screens or help pages available for that item. These names are links. You access a 
user screen or help page within a menu folder by clicking on its name. To collapse 
the pages back into the menu icon, click on the minus sign. 
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Screen Elements 
 
Specifying Information 
 
The VSS system uses a graphical user interface (GUI). Instead of having to 
memorize and type in commands, you use recognizable graphical elements on the 
screen to get things done. 
 
Common screen elements include the following. 
 
Field:  Used for entering text or numbers from the computer keyboard. The name of 
the field tells you what to enter. Click in the box and type.  
 

 
 
 
Required Field:  The red asterisk before the field name tells you that you must 
enter something in this field before you are able to post the information or move on 
to another screen.  
 

 
 
 
List Box:  Click on the selection you want. If the list is too long to fit in the box, 
there will be a "scrollbar" on the right. Click on the up or down arrows on the bar to 
scroll through the list. 
 

 
 
 
Dropdown or Pulldown List:  The dropdown list contains a list of items that you 
can select from. When you click on the arrow the list will expand. If the list is long, 
a scrollbar will appear. Click on the up or down arrows on the bar to scroll through 
the list. 
 
 

 



Introduction 

4 Voluntary Service System (VSS) User Manual September 2004 

Radio Button:  Radio buttons are another way to present options; select the option 
you want by clicking on the radio button. 
 

 
 
 
Double List Box:  There are various kinds of double list boxes, but the common 
idea is that you select from the box on one side and use buttons in the middle to 
move the items to the box on the other side. 
 

 
 
 
Performing Tasks 
 
Most of the work you perform in VSS is done with buttons. The function of a button 
is most often indicated in its name, for example: 
 

 
 
Button definitions for VSS are as follows. 
 
Post - When you have added/edited information on a screen and wish to save it to 
the database, use the Post button. 
 
Exit - The Exit button usually takes you to the opening VSS screen where the 
station dropdown list is located. In multiple screen tasks, the Exit button will take 
you back to the previous screen or the first screen in the process. 
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Edit - The Edit button is used to view or change information in an existing record.  
 
Delete - The Delete button is used to remove a record from the database. 
 
Clear - The Clear button is used to erase entries or reset fields on a screen. It is not 
used to remove data from the database. 
 
Next - When there are multiple screens for performing a particular task, the Next 
button will move you to the next screen in the sequence. You may be required to 
post one page before moving on to the next. 
 
New - The New button is used when you wish to create a new record in the 
database -- a new program, service code, volunteer, etc. 
 
Add - The Add button is used to add a new item to a list or to the database. 
 
Display - After you have specified what you want to include in a report, clicking the 
Display button allows you to see the report on the screen. 
 
 
Icons 
 
Two icons appear at the top of every VSS screen. 
 

 
Help icon - Clicking on this icon brings up a Help page explaining how to use the 
screen you are on.  
 

 
Default Station icon - Clicking on this icon brings up a dialog box that allows you 
to specify which station's data will be the default station data when you start or 
restart the application.  
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Reports 
 
Before you display a report on your screen, you are asked to specify a report format. 
Which format you select depends on what you intend to do with the data. If you 
intend to save the report as an Excel file, displaying it in the Excel format would 
make sense. In most circumstances, however, Word format is the preferred choice. 
 
After clicking the Display button, the length of time the report takes to appear 
depends on the length of the report and the traffic on the network. After the report 
appears, you can use the Print and Save commands in your browser File menu to 
print the report or to store it on your hard drive. 
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Central Office Menu 

8 Voluntary Service System (VSS) User Manual September 2004 

 
 
 



  Central Office Menu 

September 2004 Voluntary Service System (VSS) User Manual 9 

Reports 
Voluntary Service Directory 

Directory Labels 
 
 
The Voluntary Service Directory Labels screen allows you to print address labels for 
VHA stations. You can print labels for an individual station, for all stations in the 
country, or for all stations in a selected VISN or state. 
 
To print Voluntary Service directory labels 
 
Select a radio button for the Sort Labels By option. 
 

Facility: Select a facility to print labels for that facility. 
VISN: Select a VISN to print labels for all stations in that VISN.  
State: Select a state to print labels for all stations in that state.  
All Facilities: Prints labels for all VHA facilities. 

 
Select a Print Format. 
Click the Display button. The labels will appear in a browser window. 
 
To print the labels, go to the File Menu of the list’s browser window and select 
Print. 
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Reports 
Voluntary Service Directory 

Supervised Programs 
 
 
The Voluntary Supervised Programs screen allows you to print a report listing all 
Voluntary Service stations running a particular program; for example, Escort 
Service. The report lists the station number and name, the name of the Voluntary 
Chief, and primary phone number.  
 
To print a Voluntary Supervised Programs list 
 
From the Select Supervised Program list, select a Voluntary program.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Service Chiefs 
 
 
The Voluntary Service Chiefs screen allows you to print a list of Chiefs of Voluntary 
Service for all stations. The list includes station name, station number, Voluntary 
Chief name and grade. 
 
To print a list of the Voluntary Service Chiefs 
 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Service Directory 
 
 
This screen allows you to print station information from the Voluntary Service 
Directory. This directory lists information about Voluntary Services at all VHA 
facilities. You can print information for an individual facility, all facilities in the 
country, or all facilities from a selected VISN or state. 
 
Each facility listing contains contact information, a list of Voluntary Service 
programs, staff member names, positions, grades, and start dates. 
 
To print a Voluntary Service Directory report 
 
Select a radio button for the Sort Report By option. 
 

Facility: Select a facility for information on that facility only. 
VISN: Select a VISN for information on all stations in that VISN.  
State: Select a state for information on all stations in that state.  
All Facilities: Prints information for all VHA facilities. 

 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Station Information Detail 
 
 
From this screen you can display detailed information for a selected station. Some 
of the information provided includes the station's address and phone number, the 
total operating and staff costs, a list of programs, staff names, position titles, e-mail 
addresses, start date, and grade.  
 
To display a Voluntary Station Information Detail report 
 
Select a station from the Select Station list. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Station Information Contact List 
 
 
You can use this screen to display contact information for all Voluntary Service 
stations. For each station the report lists the station name and number, VISN, 
primary phone number, fax number, and name of Voluntary Chief. 
 
To print a Voluntary Station Information Contact list 
 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
National Officials 

Labels 
 
 
This screen allows you to print address labels to be used for mailings to national 
officials. You can print labels for officials within the following categories. 
 

• Representatives from specified organizations  
• Deputies from specified organizations  
• National Certifying Officials from specified organizations 
• Specified National Officials  
• Only Reps in Organizations defined as NAC Executive Members  
• All National Officials who are not Reps/Deps/NCOs  

 
The displayed address listing can be saved as a Word file in order to use Word's 
address label utility. 
 
To print labels for national officials 
 
Select the type of official. 
• If you selected Representatives, Deputies, or National Certifying Officials, the 
Available Organizations/Selected Organizations list boxes will appear. If you 
selected All National Officials, the Available Individuals/Selected Individuals list 
boxes will appear. 
Scroll through the Available list and click on the entries you wish to print labels for. 
After each selection, click on the Add button to move the entry into the Selected list 
box. 
To print labels for all listed entries, click the Add All button. 
To remove an entry from the Selected list, highlight it and click the Remove button. 
To remove all entries in the Selected list, click the Remove All button.  
• If you selected the Only Reps in Organizations defined as NAC Executive 
Members or All National Officials not Reps/Deps/NCOs, proceed to the next step.  
From the Number of Labels to Skip list, select the number of labels you want blank 
at the beginning of the list.  
Select a Print Format. Word is usually the best choice for printing. 
Click the Display button. The selected national officials labels will appear.  
To print the address listing select Print from the browser File menu. 
 
To print the labels using Word's label printing utility 
 
Select Save As from the browser menu. Open the saved file in Word. 
Select Envelopes and Labels from the Tools menu. 
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Reports 
National Officials 

Annual Joint Review 
 
 
This screen allows you to print a list of national officials whose Annual Joint 
Review (AJR) with your site is scheduled for a specified month. This list is arranged 
alphabetically by national organization name and provides the official's name, title, 
telephone number, and date appointed.  
 
To print an Annual Joint Review list 
 
Select a month from the Annual Joint Review Month dropdown list.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report’s browser window and 
select Print or Save As.  
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Reports 
National Officials 

National Officials Data View 
 
 
From this screen you can display a data view of all national officials’ information. 
Some of the data elements provided include name, ID, telephone number and 
address, title, organization code, AJR (annual joint review) month, whether the 
organization is a NAC Executive member, date appointed, and whether the official 
is in the NCO.  
 
A data view presents all the data in a database table. There is too much data in the 
data view to fit into a normal page for printing, so you will probably want to save it 
to your hard drive and then open it in Excel or Word; or you can import the saved 
file to a database program, such as Quicken or Access. At that point, you can delete 
portions of it, add to it, rearrange it, sort it, reformat it, and/or insert it into other 
applications. 
 
To display a Voluntary National Officials Data View 
 
Click Display. The Voluntary National Officials Data View will appear.  
 
To save a Voluntary National Officials Data View as an Excel or Word file 
 
Select Save As from the Internet Explorer browser File menu.  
In the Save Web Page dialog box do the following: 

In the Save In dropdown list at the top, browse to a drive and directory to store 
the data view. 
In the Filename dropdown list at the bottom, enter a filename for the data view.  
In the Save as Type dropdown list, select Web Page, complete or Web Page, HTML 
only.  
Click the Save button.  

 
To open the Data View 
 
Open Excel or Word. 
Open the data view file from the File menu.  
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Reports 
CO Reports 

Committee Attendance Listing 
 
 
This screen allows you to print a report showing VAVS site committee attendance 
during a selected fiscal year. You can select the stations individually, by VISN, by 
state, or all stations. 
 
The detailed version of the report lists the total hours for every organization plus 
the attendance hours for each representative of every organization. A non-detailed 
report lists only the organization totals.  
 
The hours recorded for VAVS committee attendance are entered as service code 
135A within a combination code. If the time is to be applied to volunteer hours, it 
must be entered manually because combinations using this code are not accessible 
via the Auto-Login system.  
 
To print a VAVS Committee Attendance listing 
 
Select a radio button for the Station Selection option. 
 

Facility: Select a facility to list attendance for that facility only. 
VISN: Select a VISN to list attendance for all facilities in that VISN.  
State: Select a state to list attendance for all facilities in that state.  
All Facilities: Lists attendance for all VHA facilities. 

 
Select the desired fiscal year within the Fiscal Year box.  
Select whether you want to print a detailed report by selecting Yes or No. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As. 
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Reports 
CO Reports 

NAC Organizations Yearly Comparison 
 
 
This screen allows you to print a report of the hours recorded by National Advisory 
Committee (NAC) Organizations. You can list the recorded hours for a selected 
station, VISN, state, or for all stations. For each organization the report shows 
hourly data for the previous five fiscal years, starting with the selected year. The 
yearly hourly data includes the following. 
 

• Number of regularly scheduled volunteers 
• Number of regularly scheduled hours 
• Number of occasional hours 
• Total number of all hours 

 
A statement is included at the bottom of the report describing how volunteers are 
counted (by unique volunteer, be each combination assignment, etc).  Inactive 
organizations that have hours posted in the selected date range will also appear on 
the report. 
 
To print a NAC Organizations Yearly Comparison report 
 
Select a radio button for the Station Selection option. 
 

Facility: Report will list organization hours for the selected station.  
VISN: Report will list organization hours for the selected VISN.  
State: Report will list organization hours for the selected state.  
All Facilities: Report will list organization hours for all facilities.  

 
Select the desired fiscal year within the Fiscal Year box.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As. 
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Reports 
CO Reports 

National Organizations 
 
 
This screen allows you to generate a report of all Voluntary Services national 
organizations. You can select whether to display all national organizations, only 
organizations on the National Advisory Council (NAC), or only organizations not on 
the NAC. 
 
The data displayed in the report includes the organization's name and code, the 
month of its Annual Joint Review (AJR), and its association with the NAC. 
 
To print a Voluntary National Organizations report 
 
Select which national organizations you want displayed. 
 

NAC Only: All national organizations represented on the NAC 
Non-NAC Only: All national organizations not represented on the NAC 
All (NAC and Non-NAC): All national organizations 

 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Reports 
CO Reports 

Utilizing Services and Subdivisions 
 
 
This screen allows you to display a report listing all volunteer hours for each service 
within a specified number of months for a specified fiscal year. The report breaks 
down each service listing by site. For each site, the report lists the following. 
 

• Number of regularly scheduled volunteers, visits, and hours  
• Number of occasional visits and hours  
• Total number of visits and hours for all volunteers 

 
You are able to choose Part I or Part II of the report. Part I lists all service 
reporting hours while Part II lists only community-service services (service 
subdivisions with the letter "T" in their code.) 
 
To display a Utilizing Services/Subdivision report 
 
Select a fiscal year from the Fiscal Year dropdown list.  
Select a month from the Including Months Through dropdown list.  
Select a Choose Reports option - Part I - ALL or Part II - Community Associations. 
Select a Print Format.  
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Reports 
CO Reports 

Regular Scheduled and Occasional Hours VHA37 Part 1 
 
 
This screen allows you to print a report showing regularly scheduled, occasional, 
and total hours recorded for organizations on the National Advisory Committee 
during a specified fiscal year. It also shows the number of hours recorded by 
representatives to VAVS meetings. You can restrict the data to a portion of the 
fiscal year and to a selected station, VISN, or state. A statement is included at the 
bottom of the report describing how volunteers are counted (by unique volunteer, by 
each combination assignment, etc).  Inactive organizations that have hours posted 
in the selected date range will also appear on the report. 
 
A companion report, Voluntary Organizations RS and Occasional Hours VHA37 
Part 2, lists the same information for national organizations that are not 
represented on the National Advisory Committee.  
 
To display a Voluntary Organizations RS and Occasional Hours VHA37 
Part 1 report 
 
Select a Station Selection option. 
 

Facility: Report will list hours for the selected station.  
VISN: Report will list hours for the selected VISN.  
State: Report will list hours for the selected state.  
All Facilities: Report will list hours recorded for all facilities.  

 
Select the desired fiscal year within the Fiscal Year box.  
For the Months option, select the number of months of data you want to include in 
the report.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As. 
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Reports 
CO Reports 

Regular Scheduled and Occasional Hours VHA37 Part 2 
 
 
This screen allows you to print a report showing regularly scheduled, occasional, 
and total hours recorded during a specified fiscal year for national organizations 
that are not on the National Advisory Committee. It also shows the number of hours 
recorded by representatives to VAVS meetings. You can restrict the data to a 
portion of the fiscal year and to a selected station, VISN, or state. A statement is 
included at the bottom of the report describing how volunteers are counted (by 
unique volunteer, by each combination assignment, etc).  Inactive organizations 
that have hours posted in the selected date range will also appear on the report. 
 
A companion report, Voluntary Organizations RS and Occasional Hours VHA37 
Part 1, lists the same information for national organizations that are on the 
National Advisory Committee.  
 
To display a Voluntary Organizations RS and Occasional Hours VHA37 
Part 2 report 
 
Select a Station Selection option. 
 

Facility: Report will list hours for the selected station.  
VISN: Report will list hours for the selected VISN.  
State: Report will list hours for the selected state.  
All Facilities: Report will list hours recorded for all facilities.  

 
Select the desired fiscal year in the Fiscal Year box.  
For the Months option, select the number of months of data you want to include in 
the report.  
Select a Print Format.  
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Reports 
CO Reports 

Regular Scheduled and Occasional Hours VS01 Part 1 
 
 
This screen allows you to print a report comparing actual and average hours for 
regular and occasional volunteers between two fiscal years. The specified fiscal year 
is compared to the year prior. The data can be restricted to a portion of the fiscal 
year and to a specified station, VISN, or state.  
 
The summary report lists the total hours only while the non-summary report 
includes the hours for each individual service. 
 
To display a Voluntary Services RS and Occasional Hours VS01 Part 1 
report 
 
Select a Station Selection option to determine the scope of the listing. 
 

Facility: Report will list hours for the selected station. 
VISN: Report will list hours for the selected VISN. 
State: Report will list hours for the selected state. 
All Facilities: Report will list hours recorded for all facilities. 

 
Select the desired fiscal year in the Fiscal Year box.  
For the Months option, select the number of months of data you want to include in 
the report.  
Choose to print summary page only, Yes or No. 
Select a Print Format.  
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Reports 
CO Reports 

Regular Scheduled and Occasional Hours VS01 Part 2 
 
 
This screen allows you to print a report of statistics about volunteers at a particular 
station. The report compares one period of a given fiscal year with the same period 
of the previous fiscal year. 
 
The first part of the report compares the increase, decrease, and overall change in 
the number of regularly scheduled volunteers at the site. It breaks the data down 
according to sex, student volunteers, volunteers affiliated and unaffiliated with 
organizations, and those recruited and terminated. It also shows the net gain or loss 
in volunteers for the compared time periods. The second part of the report compares 
the volunteers in the two fiscal year periods by age. It also provides a graph of the 
age breakdown of volunteers for the requested fiscal year. 
 
The summary only report will show totals for all selected sites. The full report will 
list the data for each selected station. If you select a single facility, the summary 
and full reports will be the same. 
 
To display a Voluntary Services RS and Occasional Hours VS01 Part 2 
report 
 
Select a Station Selection option to determine the scope of the listing. 
 

Facility: The report will list hours for the selected station. 
VISN: The report will list hours for the selected VISN. 
State: The report will list hours for the selected state. 
All Facilities: The report will list hours for the entire VHA. 

 
Using the dropdown list in the Fiscal Year field, select a fiscal year.  
For the Months option, select the number of months of data you want to include in 
the report. 
Choose to print summary page only, Yes or No. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Reports 
CO Reports 

Volunteers By Organization Data View 
 
 
This report lists volunteers by organization in an Excel spreadsheet format. 
Information appearing on the report may include station number, station name, 
organization name, organization code, organization abbreviation, volunteer name, 
volunteer address, yearly hours, and total hours. All volunteers who logged at least 
one hour during the time period for the selected organization(s) appear on the 
report. 
 
To display a Volunteers By Organization Data View report 
 
Select a beginning date and ending date for the report from the dropdown lists.  
Highlight an organization in the Available Organization box and click the Add 
button. The highlighted organization will appear in the Selected Organization box. 
Repeat the step for each organization in the list you wish to print. 
To select all listed organizations, click the Add All button.  
To remove organizations that you have selected, highlight them in the Selected 
Organization box and click the Remove button. 
To remove all selected organizations at once, click the Remove All button.  
Click the Display button. The report will appear in a browser window. 
 
To upload into Excel 
 
Print the report, select all and copy, start Excel, and paste. 
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Reports 
CO Reports 

VS01 Data View 
 
 
From this screen you can put the Regular Scheduled and Occasional Hours VS01 
Part 2 report into an Excel spreadsheet. You may select which data fields you want 
displayed from the following choices. 
 

• VISN detail (name) 
• station detail (name, address, city, state, zip code) 
• count RS on rolls 
• count RS on rolls logging hours 
• RS hours 
• occasional hours 
• adjusted hours 
• total hours 

 
The report may take 2-5 minutes to generate. 
 
To display a VS01 Data View report 
 
Using the dropdown list in the Fiscal Year field, select a fiscal year.  
For the Months option, select the number of months of data you want to include in 
the report. 
Check the data items you want displayed on the report. 
Click the Display button. The report will appear in a browser window. 
 
To upload into Excel, print the report, select all and copy, start Excel and paste. 
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Reports 
Donation Reports 

Donations Data View 
 
 
From this screen you can display a data view of all donations information for a 
station. A data view presents all the data in a database table. There is too much 
data in the data view to fit into a normal page for printing, so you will probably 
want to save it to your hard drive and then open it in Excel or Word; or you can 
import the saved file to a database program, such as Quicken or Access. At that 
point, you can delete portions of it, add to it, rearrange it, sort it, reformat it, and/or 
insert it into other applications as you see fit.  
 
The Donations Data View lists all data collected for every donation made to the 
station. This includes the institution code, donor ID, donation type, description, 
dollar value, donor name and address, donor affiliation, acknowledgment date, 
General Post Fund number, and field service receipt number.  
 
To display a Voluntary Donations Data View 
 
Click Display. The Voluntary Donations Data View will appear.  
 
To save a Voluntary Donations Data View as an Excel or Word file 
 
Select Save As from the Internet Explorer browser File menu.  
In the Save Web Page dialog box do the following. 

In the Save In dropdown list at the top, browse to a drive and directory to store 
the data view. 
In the Filename dropdown list at the bottom, enter a filename for the data view.  
In the Save as Type dropdown list, select Web Page, complete or Web Page, HTML 
only.  
Click the Save button.  

 
To open the Data View 
 
Open Excel or Word. 
Open the data view file from the File menu.  
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Reports 
Donation Reports 

Total Donations By Station 
 
 
This screen generates a comparison report showing total monetary and material 
donations for an individual station, all stations in a selected VISN, all stations in a 
selected state, or all stations. It lists the information for a specified fiscal year as 
well as the previous three fiscal years.  
 
To print a Total Donations By Station report 
 
Select a Station Selection option to determine the scope of the listing. 
 

Facility: The report will list donations for the selected station.  
VISN: The report will list donations for the selected VISN.  
State: The report will list donations for the selected state.  
All Facilities: The report will list donations for the entire VHA.  

 
Select a year from the Fiscal Year dropdown list.  
Select the desired Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Maintenance 
National Award Codes 

 
 
The National Awards Codes screen allows you to create a new voluntary service 
award or to edit the properties of an existing award. Awards are given to Voluntary 
staff annually, based on their total hours of service. Each award has a name, a 
number of hours, a number of hours required for eligibility, and a two-digit code 
used by the VSS system. Each award is also associated with an age category.  
 
It is important to understand the distinction between the number of hours of service 
that an award is for (Award Hours field) and the number of hours required to be 
eligible to receive an award (Required Hours field). Because volunteers are 
designated for awards in advance of receiving them, the hours required for 
eligibility may be less than the hours that an award represents.  
 
To add a new award code 
 
Click New. 
Enter a code for the award in the Code field.  
Enter a name for the award in the Name field.  
In the Required Hours field, enter the number of hours required to be eligible for 
this award. (This will be less than the Award Hours value.)  
In the Award Hours field, enter the number of hours of work the award is for.  
(Optional) - Select an age group for this award from the list in the Award Type field. 

Adult-21 years and over.  
Youth-under 21 years.  
Other-both Adult and Youth.  

Click Post to save your changes. “Record posted" displays at the top of the screen.  
 
To edit an existing award code 
 
Select an existing award code from the list in the Edit an existing Award Code box. 
Click Edit. 
The selected award code information will populate the screen.  
Change the information in the award fields as desired.  
Click Post to save your changes. “Record posted" displays at the top of the screen.  
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Maintenance 
National Officials Edit 

 
 
This screen allows you to create a new national official for a Voluntary Services 
organization or to edit the information for an existing official. National Officials are 
designated by Central Office to certify representatives of their national 
organizations at Veterans Affairs Voluntary Services (VAVS) meetings where 
Voluntary Services rules and policies are formulated. An official can be a 
Representative, a Deputy, or a National Certifying Official. There can be multiple 
national officials for a single organization.  
 
To add a new National Official to the database 
 
Select an organization from the Organization dropdown list.  
Enter the requested information in the fields in the middle of the page. Fields with 
asterisks are required.  
Click Post. "Record Posted" will display at the top of the screen.  
 
To change or add information for an existing National Official 
 
Select the organization associated with the official from the Organization dropdown 
list.  
Select the official from the Edit an Existing National Official dropdown list. 
Click Edit.  
Edit the fields in the middle of the screen, as appropriate.  
Click Post. "Record Posted" will display at the top of the screen.  
 
To remove an National Official from the database 
 
Select the organization associated with the official from the Organization dropdown 
list.  
Select the official from the Edit an Existing National Official dropdown list.  
Click the Delete button at the bottom of the page. The message “Record Deleted" 
will display at the top of the screen. 
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Maintenance 
National Organization Codes 

 
 
This screen allows you to add national organizations or edit the information for 
existing ones. When a national organization is added, it becomes available through 
its code for affiliation with local Voluntary Service stations.  
 
Central Office can designate a national organization as a member of the National 
Advisory Committee (NAC) which meets annually to create the rules and policies 
for all Voluntary Service organizations. The status of a NAC organization can be 
one of the following, as determined by Central Office in accordance with the 
national organization. 
 

• Service Member  
• Associate Service Member 
• Donor Member 

 
NAC organizations can also be members of the NAC Executive Committee.  
 
Central Office also designates the month for each organization to hold its Annual 
Joint Reviews (AJR) with individual stations to assess their relationship. 
 
To add a new National Organization 
 
Click New.  
The Organization Code box is populated with a new code to be assigned to the new 
organization. 
Enter the name of the new organization (up to 30 characters) in the Name of 
Organization box.  
(Optional) Enter an abbreviation for the new organization (up to 6 characters) in 
the Abbreviation box. 
Click Yes if this new organization is a member of the National Advisory Committee. 
If Yes, select the organization's National Advisory Committee status from the NAC 
Membership Status list and click Yes if the organization is an Executive member of 
the National Advisory Committee.  
Select the month from the Annual Joint Review Month list in which the 
organization holds its annual joint review.  
Click Yes if the organization is inactive.  
Click Post. “Record Posted!" displays at the top of the screen.  



  Central Office Menu 

September 2004 Voluntary Service System (VSS) User Manual 33 

Maintenance 
National Organization Codes, cont. 

 
 
To edit an existing National Organization 
Note: Only national organizations with codes between 001-899 are editable from 
this screen. 
 
Select the desired organization code from the Edit an Existing Organization Code 
box. 
Click Edit.  
The selected organization code information populates the screen boxes. 
Edit the desired boxes. 
Click Post. "Record Posted!" displays at the top of the screen. 
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Maintenance 
National Programs 

 
 
This screen allows you to add a new national Voluntary Service program or edit 
information for an existing one. Programs are non-medical activities at VHA 
facilities that can be administered locally by Voluntary Services stations. Examples 
include hospital coffee service, reception/information desk, and escort service. When 
you add a new national program, it becomes available through its code to local 
Voluntary Services stations. National program codes must be a digit between 1 and 
99. 
 
To add a new National Voluntary Service program 
 
Click New. The Current Record field displays New.  
Enter a new service program code number (between 1 and 99) in the Code box.  
Enter a new service program name (up to 30 characters) in the Program Name box. 
Click Post. "Record Posted!" displays at the top of the screen. 
 
To edit an existing program 
 
Select the desired service program code from the Edit an Existing Program Code 
box. 
Click Edit. The selected service program code information populates the screen 
boxes. 
Edit the desired boxes. 
Click Post. "Record Posted!" displays at the top of the screen. 
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Maintenance 
National Schedule Codes 

 
 
This screen allows you to add national workday schedule codes or edit the 
information for existing ones. When you add a national schedule code, it becomes 
available at local Voluntary Service sites for use in volunteer combination codes.  
 
To add a new National Schedule Code 
 
Click New. The Code field is automatically populated with a new code number. 
Enter the days of the new schedule in the Days field. Example: "Monday, Tuesday, 
Wednesday". 
Enter an abbreviation for the new schedule code in the Appears As field. Example: 
"MTW". 
Click Post. "Record Posted!" displays at the top of the screen.  
 
To edit an existing National Schedule Code 
 
Select an existing schedule code from the Edit an Existing Schedule dropdown list.  
Click Edit. The information for the selected schedule code automatically populates 
the screen fields.  
Edit the fields, as appropriate. 
Click Post. "Record Posted!" displays at the top of the screen. 
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Maintenance 
National Service Codes 

 
 
This screen allows you to add a new national service or edit an existing one. A 
national VHA service becomes available to local Voluntary Service stations through 
its code. It can then be used as part of volunteer combination codes in scheduling 
volunteer work. National service codes must be three digits between 001 and 799 
and can be followed by an uppercase alpha character. The service subdivision is the 
department whose jurisdiction the service is under.  
 
To add a National Service Code 
 
Click New. 
Enter the new service code in the Service Code box.  
Enter the name of the service (up to 22 characters) in the Name of Service box. 
(Optional) Enter an abbreviation for the service (up to seven characters) in the 
Abbreviation box.  
(Optional) Enter the service subdivision (up to 12 characters) in the Subdivision 
box.  
Click Post.  
"Record Posted!" displays at the top of the screen.  
 
To edit an existing National Service Code 
Note:  Only national service codes (001-799) are editable from this screen. 
 
Select the desired service code from the Edit an Existing Service Code box.  
Click Edit. The selected service code information populates the screen boxes.  
Edit the desired boxes.  
Click Post. "Record Posted!" displays at the top of the screen.  
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Maintenance 
National Staff Titles 

 
 
Using this screen you can create or edit the staff titles used at Voluntary Service 
stations at VHA facilities. These titles are specific to the Voluntary Services staff 
only. Central Office determines the titles to be used for Voluntary Service programs. 
 
The titles created here automatically populate the staff title select list in the 
Voluntary Services Directory/Service Staff screens. 
 
To add a new National Staff Title 
 
Click New. The Current Record indicates the record is New.  
Enter a new staff title in the Title box.  
Enter a description of the new staff title (up to 250 characters) in the Description 
area.  
Click Yes if this title is a Voluntary Chief Supervisor.  
Click Post. "Record Posted!" displays at the top of the screen.  
 
To edit an existing National Staff Title 
Note: Only national staff title records are editable from this screen. 
 
Select the desired staff title from the Edit an Existing Title box. 
Click Edit.  
The selected Voluntary Staff Title information populates the screen boxes. 
Edit the desired boxes. 
Click Post. "Record Posted!" displays at the top of the screen. 
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Maintenance 
Stations 

 
 
From this screen the Application Administrator creates basic information for new 
VHA sites or edits information for existing sites. The station information resides in 
the Institution file. This information is supplied by the station VSS Systems 
Implementation Manager when running the second VSS data migration patch.  
 
To create a new station 
 
Click New, next to Create a New Station.  
Enter the station information. Required fields are designated by an asterisk. Field 
explanations are provided below. 
 

Station Name Station name, or if the station is a substation, 
 the substation name. 
Station Number Station number, or if the station is a substation,  
 the substation number. 
VISN Select the station's VISN from the dropdown list. 
Primary Station If the station is a substation, this field will become 
 active, allowing you to select the primary station from 
 the dropdown list. 
User Administrator Selecting a user from this list automatically grants 
 that user the site’s Site User Administrator role. If 
 the desired user is not listed, use the User 
 Management screen to add that user. 

 
When you are satisfied with all the entries, click Post. If you want to exit the screen 
without entering the new information into the database, click Exit.  
 
To edit an existing station 
 
Select a station from the Edit an Existing Station dropdown list and click the Edit 
button.  
Make the necessary changes to the station's information.  
When you are satisfied with your changes, click Post. If you want to exit the screen 
without entering the new information into the database, click Exit.  



  Central Office Menu 

September 2004 Voluntary Service System (VSS) User Manual 39 

User Administration 
User Management 

 
 
The User Management screen can only be accessed by the site administrator. The 
administrator uses this screen to assign roles to site users. The role determines 
what data the user will have access to. 
 
The term “user” refers to Voluntary staff members, not volunteers. Volunteers are 
administered through the Add Volunteers and Edit Volunteers screens. 
 
Once you assign a new primary station to a user, only the user administrator at the 
new station can edit that user's personal data. Roles, however, can still be added 
and removed.  
 
To create a new Voluntary Service user in the VSS System 
 
Enter the information for the following fields. 
 

Last Name, First Name, Middle Name or Initials 
NT User Name - Enter the domain name followed by a back slash and then the 
full NT user name. (Example: VHAMASTER\VHAAREALASTNAMEF) 
E-mail Address 
 

Select your site's name from the Primary Station dropdown list.  
 
Highlight one of the roles listed in the Roles box and click the right arrows to assign 
it to the new user. The assigned role will appear in the Current Roles box. You can 
repeat this step to assign more than one role to a single user. If you make a 
mistake, highlight the role you want to delete in the Current Roles box and click the 
left arrows. The role will disappear from the Current Roles box.  
 
When all of the information appears correct, click the Post button to enter it into the 
database.  
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User Administration 
User Management, cont. 

 
 
To change/add/delete a role for an existing user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information.  
Highlight the desired role(s) and use the right and left arrows to assign/unassign 
the role(s). 
When you are satisfied with the user's role assignment(s), click the Post button to 
enter the change into the database.  
 
To change the primary station for a user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information. 
Click the Back button on the browser window. 
Select the user's new primary station from the Primary Station dropdown list. 
Click the Post button to enter the change into the database.  
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User Administration 
User Reports 

 
 
You can use this screen to display computer system information for each VSS staff 
person at your station. This information includes domain and user name, E-mail 
address, and VSS role. The VSS role determines the screens to which the user has 
access. The report can be sorted by either user role or name. 
 
To display a user report 
 
Select your station from the Select Division field. 
Select either User or Role for the Group by option.  
Select the desired print format. 
Click Display. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As. 
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Games 
Games Reports 

Address Labels (Games) 
 
 
You can use this screen to print address labels for registered Games volunteers 
associated with a selected Games. You can select the labels to print by age range, 
organization, or service. You can also specify a particular volunteer, all volunteers, 
or all volunteers who are VAVS representatives.  
 
Highlight the desired games in the Select Game box.  
 
Address labels by age range 
Select Age Range from the Select Labels By dropdown list. 
Select a beginning age from the From list and an ending age from the To list.  
Select a print format and click Display. The address labels will appear.  
 
Address labels by organization 
Select Organization from the Select Labels By dropdown list. 
Select an organization from the dropdown list of organization names.  
Select a print format and click Display. The address labels will appear.  
 
Address labels by service 
Select Service from the Select Labels By dropdown list. 
Select a service from the dropdown list of service names. 
Select a print format and click Display. The address labels will appear.  
 
Address labels for a specific volunteer 
Select Selected Volunteers from the Select Labels By dropdown list.  
A list of current registered volunteers for the selected Games will appear. If you 
wish to search the list you can do so by name, SSN, or station. Select your preferred 
search method, enter the appropriate value in the “for” box, and click the Search 
button. 
Once you have the desired entry, click the Display button next to the volunteer’s 
name to display the address label. 
 
Address labels for all site volunteers 
Select All Volunteers from the Select Labels By dropdown list.  
Select a print format and click Display. The address labels will appear.  
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Games 
Games Reports 

Address Labels (Games), cont. 
 
 
Address labels for all VAVS representatives 
Select All VAVS representatives from the Select Labels By dropdown list. 
Select a print format and click Display. The address labels will appear.  
 
To print the address labels 
Using the browser File menu, select Print. 
Select Save As to save the address list to your hard drive for future use.  
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Games 
Games Reports 

Daily Work Schedule 
 
 
Using this screen you can display a report listing all Games volunteers working on 
specified days of the week. For each day specified the report lists the following. 
 

• all scheduled volunteers  
• each volunteer's pseudo code (first initial followed by last four SSN digits)  
• all available workday codes  
• each volunteer's service code and service name 

 
To display a Daily Work Schedule for Games volunteers 
 
Highlight the desired Game in the Select Game box.  
Check the appropriate Select Days check boxes to specify the days of the week to 
display.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Use Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Master Registration List 
 
 
This screen lets you display an alphabetical list of all registered volunteers for a 
specified Game. For each volunteer listed, the report shows a volunteer pseudo code 
and a combination code assignment.  
 
To display a Master Registration list 
 
Highlight the desired Game in the Select Game box.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Organization Regular Scheduled Hours 
 
 
Using this screen, you can display a report listing data on Games volunteers and 
their hours of service for specified Games organizations. The report may be printed 
with details (Show Detail - Yes) and without details (Show Detail - No). Both forms 
of the report list the following information. 
 

• Hour and visit totals for volunteers in each organization  
• Age and gender statistics for volunteers in each organization  
• Volunteer totals and statistics for all organizations listed in the report 

 
The with details report option lists each volunteer within each selected 
organization. It lists the volunteer's name, code, gender, age, organization codes, 
schedule codes, total visits, and total hours. The without details report option 
displays totals only. 
 
In both forms of the report, when no hours have been recorded for a specified 
organization, that organization does not appear in the report.  
 
To display a Games Organization RS Hours report 
 
Select the Games type you want from the Select Games list box.  
Select the year for the report from the Fiscal Year dropdown list.  
Select No or Yes for the Show Detail option. 
Highlight an organization (or group of organizations) in the Available Organizations 
box 
Click the Add button. The highlighted organization(s) will appear in the Selected 
Organizations box. 
To select all listed organizations, click the Add All button.  
To remove organizations that you have selected, highlight them in the Selected 
Organizations box and click the Remove button. 
To remove all selected organizations at once, click the Remove All button.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Service Assignment Schedule 
 
 
This screen lets you view the volunteers assigned to Games services. For each 
service listed the report shows the names, pseudo codes, and workday code for the 
volunteers. 
 
To display a Service Assignment Schedule 
 
Highlight the desired Game in the Select Game box.  
Highlight a service (or group of services) in the Available Services box. 
Click the Add button. The highlighted service(s) will appear in the Selected Services 
box. 
To select all listed services, click the Add All button.  
If you wish to remove services that you have selected, highlight them in the 
Selected Services box and click the Remove button.  
If you wish to remove all selected services at once, click the Remove All button. 
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Service Regular Scheduled Hours 
 
 
Using this screen, you can display a report listing data on Games volunteers and 
their hours of service for specified Games services. The report may be printed with 
details (Show Detail - Yes) and without details (Show Detail - No). Both forms of the 
report list the following information. 
 

• Hour and visit totals for volunteers in each service  
• Age and gender statistics for volunteers in each service  
• Volunteer totals and statistics for all services listed in the report 

 
The with details report option lists each volunteer within each selected service. It 
lists the volunteer's name, code, gender, age, organization codes, schedule codes, 
total visits, and total hours. The without details report option displays totals only. 
 
In both forms of the report, when no hours have been recorded for a specified 
service, that service does not appear on the report.  
 
To display a Games Service RS Hours report 
 
Select the Games type you want from the Select Games list box.  
Select the year for the report from the Fiscal Year dropdown list.  
Select No or Yes for the Show Detail option. 
Highlight a service (or group of services) in the Available Services box. 
Click the Add button. The highlighted service(s) will appear in the Selected Services 
box. 
To select all listed services, click the Add All button.  
To remove services that you have selected, highlight them in the Selected Services 
box and click the Remove button.  
To remove all selected services at once, click the Remove All button.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Shirt Issue List 
 
 
This screen lets you print a report which can be used to issue Games shirts to 
volunteers. The report lists the volunteer names in alphabetical order, along with 
pseudo codes, shirt sizes, and spaces for signatures. The list provides a record of 
volunteers who have received their shirts and those who have not. The shirt sizes 
are specified when the volunteers register.  
 
To print a Shirt Issue List 
 
Highlight the desired Game in the Select Game box.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  



Central Office Menu 

50 Voluntary Service System (VSS) User Manual September 2004 

Games 
Games Reports 

Sign In Roster 
 
 
This screen lets you print a sign-in sheet for volunteers reporting for work. Under 
each selected day of the week it lists service, service code, all scheduled volunteers, 
their pseudo code, and workday code. It includes a space for volunteers to sign in 
and a box for the staff person to check off. 
 
The roster can be sorted by last name or service assignment. Last Name lists all 
volunteers (in alphabetical order) working on each workday. Service Assignment 
lists all services for each day of the week in service code order. The volunteers are 
then listed in alphabetical order under each service.  
 
To display a Sign-In Roster 
 
Highlight the desired Game in the Select Game box.  
Check one or more Select Days check boxes to choose which days will be included on 
the roster. 
Select a Sort By radio button.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  



  Central Office Menu 

September 2004 Voluntary Service System (VSS) User Manual 51 

Games 
Games Reports 

Telephone List (Games) 
 
 
This screen lets you print a telephone list for all Games volunteers. The telephone 
list includes the pseudo code and telephone number(s) for each volunteer. 
 
To print a Games Telephone List 
 
Highlight the desired Game in the Select Game box.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Scheduling 

 
 
Central Office uses the Scheduling screen to set start and end dates for each annual 
VHA Games for a particular year. The purpose of this screen is to specify the time 
period during which volunteers can legitimately log hours. The screen allows you to 
create a schedule for a Game for the first time or to change an existing schedule.  
 
In most cases, there will be only one Games type per host location. In some cases, 
the start and end dates for a Games type for two consecutive years will overlap, so 
the Games type will be listed twice. 
 
When scheduling Games dates in the VSS system, it is very important to include 
time before or after the Games when volunteers may be working. Otherwise, 
volunteer hours may not be counted by the system.  
 
To add a Games Schedule 
 
Click the Add button. The Games Scheduling screen appears. 
Select your station from the Host Station dropdown list. 
Select a Game type from the Games Type dropdown list. 
Type a date in the Start Date field or click Calendar and click a date in the 
Calendar popup that appears. Use the arrows in the upper corners of the calendar 
to change the month. 
Type a date in the End Date field or click Calendar and click a date in the Calendar 
popup that appears. Use the arrows in the upper corners of the calendar to change 
the month. 
Click Save. The Games schedule will appear on the Schedule screen list.  
 
To edit a Games Schedule 
 
Click the Edit button for the Game schedule you wish to change. The Games 
Scheduling screen appears. 
Edit the fields as appropriate. 
Click Save. The Games schedule will display your changes.  
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Maintenance 
Stations 

 
 
From this screen the Application Administrator creates basic information for new 
VHA sites or edits information for existing sites. The station information resides in 
the Institution file. This information is supplied by the station VSS Systems 
Implementation Manager when running the second VSS data migration patch.  
 
To create a new station 
 
Click New, next to Create a New Station.  
Enter the station information. Required fields are designated by an asterisk. Field 
explanations are provided below. 
 

Station Name Station name, or if the station is a substation, the 
 substation name. 
Station Number Station number, or if the station is a substation, the  
 substation number. 
VISN Select the station's VISN from the dropdown list. 
Primary Station If the station is a substation, this field will become 
 active, allowing you to select the primary station from 
 the dropdown list. 
User Administrator Selecting a user from this list automatically grants 
 that user the site’s Site User Administrator role. If 
 the desired user is not listed, use the User 
 Management screen to add that user. 

 
When you are satisfied with all the entries, click Post. If you want to exit the screen 
without entering the new information into the database, click Exit.  
 
To edit an existing station 
 
Select a station from the Edit an Existing Station dropdown list and click the Edit 
button.  
Make the necessary changes to the station's information.  
When you are satisfied with your changes, click Post. If you want to exit the screen 
without entering the new information into the database, click Exit.  
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Maintenance 
Web Configuration 

 
 
From this screen the Application Administrator specifies various config file settings 
that allow the VSS system to run over the Web. These settings should be verified by 
the VSS System Administrator. 
 
There are two config files, one for the auto-login application (VtkUser) and one for 
the VSS application itself (Vtk). You must create these config files with correct 
settings for the application to run. From time to time some of these settings may 
require updating - the application version number, for example.  
 
To create the Web config file for the VSS application 
 
Click the Vtk or VtkUser radio button. 
 
Enter the Application Settings. 
 
Name Name of the application 
Version Application version 
Security Policy Path Location for the security policy 
Application Path (Vtk) Location for the application executable 
Timeout (Vtkuser) Enter 300 for the number of seconds of inactivity 
 before auto-login user is logged out.  
 
Specify the Database Settings. 
 
DSN Name Dedicated server name for the database 
Database Database name 
User Name Database user name 
Password  VSS application database password 
Connection String String that the application uses to connect to the database  
 
To put the settings into effect, click Save.  
To exit the screen without putting the new settings into effect, click Exit.  
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User Administration 
User Management 

 
 
The User Management screen can only be accessed by the site administrator. The 
administrator uses this screen to assign roles to site users. The role determines 
what data the user will have access to. 
 
The term “user” refers to Voluntary staff members, not volunteers. Volunteers are 
administered through the Add Volunteers and Edit Volunteers screens. 
 
Once you assign a new primary station to a user, only the user administrator at the 
new station can edit that user's personal data. Roles, however, can still be added 
and removed.  
 
To create a new Voluntary Service user in the VSS System 
 
Enter the information for the following fields. 
 

Last Name, First Name, Middle Name or Initials 
NT User Name - Enter the domain name followed by a back slash and then the 
full NT user name. (Example: VHAMASTER\VHAAREALASTNAMEF) 
E-mail Address 
 

Select your site's name from the Primary Station dropdown list.  
 
Highlight one of the roles listed in the Roles box and click the right arrows to assign 
it to the new user. The assigned role will appear in the Current Roles box. You can 
repeat this step to assign more than one role to a single user. If you make a 
mistake, highlight the role you want to delete in the Current Roles box and click the 
left arrows. The role will disappear from the Current Roles box.  
 
When all of the information appears correct, click the Post button to enter it into the 
database.  
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User Administration 
User Management, cont. 

 
 
To change/add/delete a role for an existing user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information.  
Highlight the desired role(s) and use the right and left arrows to assign/unassign 
the role(s). 
When you are satisfied with the user's role assignment(s), click the Post button to 
enter the change into the database.  
 
To change the primary station for a user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information. Click the Back button on the browser window. 
Select the user's new primary station from the Primary Station dropdown list. 
Click the Post button to enter the change into the database.  
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User Administration 
User Reports 

 
 
You can use this screen to display computer system information for each VSS staff 
person at your station. This information includes domain and user name, E-mail 
address, and VSS role. The VSS role determines the screens to which the user has 
access. The report can be sorted by either user role or name. 
 
To display a user report 
 
Select your station from the Select Division field. 
Select either User or Role for the Group by option.  
Select the desired print format. 
Click Display. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As. 
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Time Posting 
Single Day Regular Hours 

 
 
This screen is used to enter the hours of multiple volunteers for a single day. It is 
normally used to enter the hours quickly at the end of the day when volunteers 
have logged their hours on a sign-in sheet. 
 
If your site does not have an auto-login kiosk, or it is not functioning properly, you 
can use this screen to post regular volunteer hours on a daily basis. 
 
The Current Time Sheets list shows all regular volunteers who have posted hours 
during the selected day (including auto-login signed-in hours). Each time sheet in 
the list shows the volunteer's name and ID, the date, the number of hours logged, 
and the organization and service.  
 
You can limit the items you see in the list by "sorting" it to include only time sheets 
with specific volunteers, organizations, services, or a specific number of hours. For 
example, by sorting the list by "Organization" and "Disabled American Veterans," 
you would see only time sheets with hours credited to Disabled Veterans.  
 
You cannot use this screen to post hours for multiple days or for regular or 
occasional volunteers. To post hours for multiple days for single volunteers, use the 
Multiple Postings Regular Hours screen. To post hours for occasional volunteers, 
use the Occasional Hours screen. 
 
To post single day regular hours for a volunteer 
 
Select a date from the Month/Year and Day dropdown lists or accept the current 
date defaults.  
Enter three or more characters of the volunteer's last name in the Volunteer Last 
Name field. Click the Choose Volunteer button. The Select Volunteer dropdown list 
appears. Select the volunteer's name from that list. 
The volunteer's combination code information populates the Combination Code field 
in the middle of the screen. Accept the default or select a combination code from the 
dropdown list in the Combination Code field if more than one exists.  
Select the number of hours from the Hours dropdown list.  
Click the Post button. "Record Posted" appears at the top of the screen and a new 
time sheet will appear in the Current Time Sheets list.  
To enter hours for the next volunteer for the same day, repeat the steps from the 
Volunteer Last Name field.  
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Time Posting 
Single Day Regular Hours, cont. 

 
 
Editing single day regular hours 
 
Enter a date with the Month/Year and Day dropdown lists.  
Click the Edit button to the left of the time sheet in the Current Time Sheets list 
that you wish to edit. The time sheet information will appear in the Enter/Edit 
Form area of the screen.  
Select the correct entries from the Combination Code and/or Hours dropdown lists.  
Click the Post button. The revised information will be added to the volunteer's 
record in the Current Time Sheets list. 
 
To delete a volunteer's single-day hours record 
 
Enter a date with the Month/year and Day dropdown lists.  
Click the Edit button to the left of the time sheet in the Current Time Sheets list 
that you wish to delete. The time sheet information will appear in the Enter/Edit 
Form area of the screen.  
Click the Delete button. "Record Deleted!" will appear at the top of the screen. 
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Time Posting 
Multiple Postings Regular Hours 

 
 
From this screen you can post hours for regular volunteers who have recorded their 
hours for multiple days on time cards. This screen allows you to post, view, and edit 
hours easily for a single volunteer on several dates. You are limited to the previous 
four months, including the current month. 
 
Each daily posting of a volunteer's hours appears as a separate record, or time 
sheet, in the screen's Current Time Sheets list. Each time sheet shows the 
volunteer's name, date and hours worked, organization, and service. 
 
To post hours for regular volunteers on a daily basis, use the Single Day Regular 
Hours screen. To post hours for occasional volunteers, use the Occasional Hours 
screen. 
 
To add a volunteer's hours for a given day 
 
Select the volunteer by doing one on the following. 
 

• Enter the first three or more characters of the volunteer's last name in the 
Last Name field and click the List by Name button.  

• Enter the volunteer's social security number in the SSN field and click the 
List by SSN button.  

• Enter the Volunteer's 5-character code in the First Letter/SSN field and click 
the List by Code button.  

 
The volunteer’s name (or a list of matching entries) will appear in the box. 
Select the volunteer's name from the box and click the Choose button. A new screen 
appears.  
Select the desired month/year from the Month/Year dropdown list. 
Select the desired day from the Date dropdown list.  
Select a code from the Combination Code dropdown list (limited to those that were 
set up for this volunteer). 
Select the number of hours the volunteer worked on this date from the Hours 
dropdown list.  
Click the Post button. "Record Posted” appears at the top of the screen. The 
volunteer's time sheet information displays in the Current Time Sheets area.  
To enter hours for another date for this volunteer, enter the new date and repeat. 
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Time Posting 
Multiple Postings Regular Hours, cont. 

 
 
To edit volunteer time sheets 
 
Select the volunteer by doing one on the following. 
 

• Enter the first three or more characters of the volunteer's last name in the 
Last Name field and click the List by Name button.  

• Enter the volunteer's social security number in the SSN field and click the 
List by SSN button.  

• Enter the Volunteer's 5-character code in the First Letter/SSN field and click 
the List by Code button.  

 
The volunteer’s name (or a list of matching entries) will appear in the box. 
Select the volunteer's name from the box and click the Choose button. A new screen 
appears.  
Select a month/year from the Month/Year dropdown list. 
Scroll down to the Current Time Sheets list. You can limit the entries you see in the 
Current Time Sheets list by "sorting" it to include only time sheets with specific 
volunteers, organizations, services, or a specific number of hours.  Select a search 
method from the Sort By dropdown list and fill in the “for” field.  Click the Sort 
button. 
Click Edit next to the time sheet entry you wish to edit. The volunteer's time sheet 
information will appear in the Enter/Edit form area.  
To change the date, combination code, or number of hours, select from the 
appropriate dropdown lists in the Enter/Edit Form area. 
Click the Post button. "Record Posted!" will appear at the top of the screen.  
 
To edit the time sheet for the same volunteer but a different month, select a 
different month from the Month/Year list. Time sheets for the new month will 
appear in the Current Time Sheets list.  
To view the time sheets of a different volunteer, click the Choose Volunteer button 
at the top of the screen. 
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Time Posting 
Multiple Postings Regular Hours, cont. 

 
 
To delete the time sheet for a regular volunteer 
 
Select the volunteer by doing one on the following. 
 

• Enter the first three or more characters of the volunteer's last name in the 
Last Name field and click the List by Name button.  

• Enter the volunteer's social security number in the SSN field and click the 
List by SSN button.  

• Enter the Volunteer's 5-character code in the First Letter/SSN field and click 
the List by Code button.  

 
The volunteer’s name (or a list of matching entries) will appear in the box. 
Select the volunteer's name from the box and click the Choose button. A new screen 
appears.  
Select a month/year from the Month/Year dropdown list. 
Scroll down to the Current Time Sheets list. Click Edit next to the time sheet entry 
you wish to edit. The volunteer's time sheet information will appear in the 
Enter/Edit form area.  
Click the Delete button. "Record Deleted!" will appear at the top of the screen. 
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Time Posting 
Occasional Hours 

 
 
This screen allows you to post and view the hours credited to organizations by 
occasional volunteers. You can also edit or delete entries for up to four months prior 
(including the current month).  
 
The Current Occasional Time Sheets display at the bottom of the screen lists all 
entries for a specified month. Each time sheet includes the date, the total number of 
hours, the organization to which the hours were credited, and an automatically 
assigned ID number. Volunteer names are not recorded.  
 
To add occasional volunteer hours 
 
Select a month/year from the Month/Year dropdown list. 
Select a sort method for the Current Occasional Time Sheets display from the Sort 
List By dropdown list. Click the Get Time Sheets button. 
Select a day from the Date dropdown list.  
Select the organization name or code from the Organization dropdown list. 
Select the service name or code from the Service dropdown list.  
Enter any remarks in the Comments field. (Optional)  
Enter the number of occasional volunteers who worked on the project in the 
Number in Group field.  
Enter the total number of hours the volunteers worked on the project in the Total 
Hours field.  
Click Post. "Record Posted!" will appear at the top of the screen and the new 
volunteer time sheet record will appear in the Current Occasional Time Sheets list. 
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Time Posting 
Occasional Hours, cont. 

 
 
To view or edit occasional volunteer time sheets 
 
Select a month/year from the Month/Year dropdown list. 
Select a sort method for the Current Occasional Time Sheets display from the Sort 
List By dropdown list. Click the Get Time Sheets button. 
Click Edit next to the time sheet entry you wish to change/view. The time sheet 
information populates the Enter/Edit Form area.  
Edit the fields in the Enter/Edit Form area as necessary.  
Click the Post button. "Record Posted" will display at the top of the screen and the 
changes will be reflected in the Current Occasional Time Sheets list.  
 
To delete an incorrect time sheet entry 
 
Select a month/year from the Month/Year dropdown list. 
Select a sort method for the Current Occasional Time Sheets display from the Sort 
List By dropdown list. Click the Get Time Sheets button. 
Click Edit next to the time sheet entry you wish to delete. The time sheet 
information populates the Enter/Edit Form area.  
Click the Delete button. "Record Deleted!" will appear at the top of the screen. 
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Volunteer Records 
Add Volunteer 

 
 
Use this screen to add a new person to the Volunteer database as a regular 
volunteer. Categories of information which may be added include ID, contact, 
combination codes, next-of-kin, station profile, and parking sticker. A combination 
code consists of the service a volunteer works for, the organization that the 
volunteer's hours for this service are credited to, and the volunteer's weekly work 
schedule for the service. All regular volunteers must have at least one combination 
code.  
 
The Merge function is used to choose a single master record for a volunteer who has 
master records at more than one site. The VSS database should contain only one 
master record for a single SSN. Use of the Merge function produces the following. 
 

• A single master record containing the volunteer's name, SSN, and personal 
information.  

• Both sets of station profile information (contact and next-of-kin). Each profile 
remains viewable at the appropriate site only.  

• Separate, unaltered hours and awards information for each site.  
 
To add a new volunteer record 
 
Enter the volunteer's last name and Social Security Number. 
Click the Search for Existing Volunteer button. The Add Volunteer screen appears.  
Enter the volunteer's personal information. Asterisks designate required fields. 
When you have finished entering the information, click the Next button. 
 
The Combination Codes screen appears. 
Select an organization from the dropdown list in the Organization field.  
Select a schedule from the dropdown list in the Schedule Workday field.  
Select a service from the dropdown list in the Service field.  
If the volunteer has an inactive status, check the Inactive check box.  
Click the Post button. The new combination code will appear in the Combination 
Codes for this Volunteer list. 
When you have finished entering the information, click the Next button. 
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Volunteer Records 
Add Volunteer, cont. 

 
 
The Next of Kin screen appears. This screen is optional. Fill in the fields if you wish 
and click the Post button.  Click the Finish button to proceed to the next screen. 
 
Click the Station Profile link.  The Station Profile screen appears. 
Accept the defaults in the Record Entry Date and Years at Station fields if 
appropriate. Fill in the other fields if necessary. Click the Post button. 
Click the Exit button. 
 
Click the Parking Stickers link if you wish to enter parking sticker data. The 
Parking Stickers screen appears. 
Type in the information for the Sticker Number, State, and License Plate fields.  
The sticker number consists of your station number, a hyphen, and then the 
volunteer’s parking sticker number up to 13 characters (i.e., 503-P111). 
Click Post.  
Since a volunteer can have multiple stickers for multiple cars, repeat as necessary. 
Click the Exit button. 
 
If the volunteer has records at a different site and you wish to merge them click the 
Merge Volunteer link. The Search for Volunteer to Merge screen appears.  
Select from the Search Station dropdown list the station whose data you would like 
to merge with yours.  
Enter the volunteer's SSN or pseudo SSN used at the other station.  
Click the Search for Existing Volunteer button. If the volunteer exists at the other 
site under the ID you have entered, his/her name will appear in the box.  
Select the volunteer's name in the box and click the Choose button.  
Another screen appears listing the volunteer's name, SSN, date of birth, and sex, as 
they have been recorded at both stations.  
Select the station whose volunteer ID data you wish to retain for both stations by 
checking the Keep check box under that station (the other will be deleted). 
Click the Merge button. If you have checked the correct checkbox for the 
information you wish to keep, click OK. 
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Volunteer Records 
Edit Volunteer 

 
 
The Edit Volunteer screen allows you to access all of a volunteer's data for 
viewing/editing. Categories of information which may be edited include ID, contact, 
combination codes, next-of-kin, station profile, and parking sticker. 
 
The Merge function is used to choose a single master record for a volunteer who has 
master records at more than one site. The VSS database should contain only one 
master record for a single SSN. Use of the Merge function produces the following. 
 

• A single master record containing the volunteer's name, SSN, and personal 
information.  

• Both sets of station profile information (contact and next-of-kin). Each profile 
remains viewable at the appropriate site only.  

• Separate, unaltered hours and awards information for each site.  
 
The Station Profile screen is used to maintain important information relating to a 
volunteer's work performance. This screen allows staff to do the following. 
 

• Verify a volunteer's hours of service  
• Adjust a volunteer's hours for prior years  

Adjustments to prior year hours are generally made when a volunteer is 
transferring hours from another station or a previously terminated volunteer 
is returning to active status and wants credit for hours logged in the old 
Volunteer Timekeeping System. 

• Record volunteer awards information after an awards ceremony  
• Terminate or reactivate volunteers (station manager only)  
• Specify the number of meals a volunteer is eligible for each day (station 

manager only)  
• Record important notes about a volunteer 
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Volunteer Records 
Edit Volunteer, cont. 

 
 
To edit a volunteer's record 
 
Select the volunteer by doing one on the following. 
 

• Enter the first three or more characters of the volunteer's last name in the 
Last Name field and click the List by Name button.  

• Enter the volunteer's social security number in the SSN field and click the 
List by SSN button.  

• Enter the volunteer's 5-character code in the First Letter/SSN field and click 
the List by Code button.  

 
The volunteer’s name (or a list of matching entries) will appear in the box. 
Select the volunteer's name from the box and click the Choose button. The Edit 
Volunteer screen appears.  
Make the necessary changes to the Master Record data fields.  
Click Post to save the changes into the database. "Record Posted" will display at the 
top of the screen. 
 
Contact Information 
If you wish to edit contact information, click the Contact Information link.  The 
Volunteer Contact Information screen appears. 
Edit the fields as necessary and click the Post button.  Click the Exit button. 
 
Next of Kin 
If you wish to edit next-of-kin information, click the Next of Kin link.  The Next of 
Kin screen appears. 
Edit the fields as necessary and click the Post button.  Click the Exit button. 
To delete an Unreferenced Next of Kin Record 
A next of kin designation that is not currently used by a station is called an 
unreferenced record. You can tell if you have unreferenced records if the number of 
names in the Next of Kin dropdown list is longer than the number of stations the 
volunteer reports to.  
Click the Delete Unreferenced Next of Kin Records link. The Delete Unreferenced 
Next of Kin Records screen appears. 
Click the Delete button next to the unused next-of-kin name in the list. 
 
Station Profile 
If you wish to edit station profile information, click the Station Profile link.  The 
Station Profile screen appears. The following table describes the fields on the 
Station Profile screen. 
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Volunteer Records 
Edit Volunteer, cont. 

 
 

Record Entry Date 
Displays the date that the original profile was 
created. Unless this date is wrong, do not change it 
when editing information.  

Years at Station 
If the volunteer is transferring from another 
station, enter the number of years served at the 
prior station.  

Method of Transportation Method of transportation the volunteer plans to 
use. 

Number of Meals Eligible for 
Number of meals the volunteer will be eligible for 
on a daily basis if the required number of hours is 
met.  

Date of Last Award Date of the last award the volunteer received. 

Award Code Name of the last award the volunteer received. 

Termination Date If the volunteer is going to be terminated, enter the 
date when the termination will be effective.  

Terminated with Cause If the volunteer is not being terminated voluntarily, 
but as a result of a performance problem, check Yes.

Terminated Remarks  Appears if the Terminated with Cause checkbox is 
checked. Enter an explanation for the termination.  

Remarks Any special comments about the volunteer. 

Add Adjusted Hours Use this button if you want to adjust the number of 
hours for a volunteer for a previous fiscal year. 

Clear Termination Date If a terminated volunteer is returning to service, 
click the Clear button. 

Display Only Fields 

Hours of Last Award Number of hours for which the volunteer last 
received an award. 

Adjusted Hours Served Total number of adjusted hours for previous years. 

Prior Year Hours Served 
Displays the total hours that were migrated during 
VSS implementation from the old Voluntary 
Timekeeping application. 

Current Year Hours Served 
Displays the total number of hours served for the 
current year only, automatically computed from auto-
login or regular hours postings. 

Total Hours Served Displays the total hours served for all years. 

 
Enter/edit the fields as necessary and click the Post button. 
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If you wish to adjust a volunteer's hours for a prior year 
Click the Add Adjusted Hours button.  The Adjusted Hours screen appears. 
Enter a date for the adjustment by making selections from the Month, Day, and 
Year dropdown lists. The date can be an actual date for which hours were logged or 
an arbitrary date for adding or subtracting an accumulated number of hours. 
In the Hours field, enter the number of hours to add or subtract. To subtract hours, 
precede the number with a minus sign.  
In the Description field, enter the reason for the adjustment.  
Click Post to enter the adjustment into the database.  
If successful, you will see "Record Posted" at the top of the screen and the entry 
listed at the bottom of the screen under Adjustments for this Volunteer.  
Click the Clear button if you wish to make an adjustment for another date.  
Click the Exit button to return to the Station Profile screen. 
 
Combination Codes 
If you wish to edit combination code information, click the Combination Codes link.  
The Combination Codes screen appears. 
To add a new combination code 
Select an organization from dropdown list in the Organization field.  
Select a schedule from the dropdown list in the Schedule Workday field.  
Select a service from the dropdown list in the Service field.  
If the volunteer has an inactive status, check the Inactive check box.  
Click the Post button. The new combination code will appear in the Combination 
Codes for this Volunteer list. 
To edit an existing combination code 
Click the Edit button next to the combination code you wish to edit in the 
Combination Codes for this Volunteer list. The information for this code will 
populate the fields on the screen. Edit the fields as necessary. 
Click the Post button. The edited combination code will appear in the Combination 
Codes for this Volunteer list.  
Click the Exit button.  
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Parking Stickers 
If you wish to edit parking sticker information, click the Parking Stickers link.  The 
Parking Stickers screen appears. 
To add a new parking sticker 
Type in the information for the Sticker Number, State, and License Plate fields.  
The sticker number consists of your station number, a hyphen, and then the 
volunteer’s parking sticker number up to 13 characters (i.e., 503-P111). 
Click the Post button.  
Since a volunteer can have multiple stickers for multiple cars, repeat as necessary. 
Click the Exit button. 
To edit an existing parking sticker 
Click the Edit button next to the parking sticker information you wish to edit. The 
information for this sticker will populate the fields on the screen. Edit the fields as 
necessary. 
Click the Post button. Click the Exit button.  
 
Merge Volunteer 
If the volunteer has records at a different site and you wish to merge them click the 
Merge Volunteer link. The Search for Volunteer to Merge screen appears.  
Select from the Search Station dropdown list the station whose data you would like 
to merge with yours.  
Enter the volunteer's SSN or pseudo SSN used at the other station.  
Click the Search for Existing Volunteer button. If the volunteer exists at the other 
site under the ID you have entered, his/her name will appear in the box.  
Select the volunteer's name in the box and click the Choose button.  
Another screen appears listing the volunteer's name, SSN, date of birth, and sex, as 
they have been recorded at both stations.  
Select the station whose volunteer ID data you wish to retain for both stations by 
checking the Keep check box under that station (the other will be deleted). 
Click the Merge button. If you have checked the correct checkbox for the 
information you wish to keep, click OK. 
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Using this screen you can display and print all the personal and station-related 
information about any site volunteer. Personal information includes such items as 
volunteer's address and telephone number, next of kin, date of birth, and license 
plate number. Station information includes such items as the volunteer's station 
code and name, combination codes, years of service, awards, and hours served.  
 
To Display a Volunteer’s Information 
 
Select the volunteer by doing one on the following. 
 

• Enter the first three or more characters of the volunteer's last name in the 
Last Name field and click the List by Name button. 

• Enter the volunteer's social security number in the SSN field and click the 
List by SSN button. 

• Enter the Volunteer's 5-character code in the First Letter/SSN field and click 
the List by Code button.  

 
The volunteer's name (or a list of matching entries) will appear in the box. 
Select the volunteer's name from the box and click the Choose button. 
Select a print format. 
Click the Display button. The report will appear in a browser window.  
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Address Labels 
 
 
The Volunteer Address Labels screen allows you to print address labels for mailings 
to volunteers associated with a selected station. You can print labels for specific 
volunteers, all volunteers, or all Veterans Administration Voluntary Services 
(VAVS) representatives. You can print the labels based on organization, service, age 
range, or birth month.  
 
Click on the desired entry listed in the Select Station box. 
 
To print volunteer address labels by age range 
Select Age Range from the Select Labels By dropdown list. 
Select a beginning age from the From list and an ending age from the To list.  
Select a print format and click Display. The address labels will appear.  
 
To print volunteer address labels by birth month 
Select Birth Month from the Select Labels By dropdown list. Select a month. 
Select a print format and click Display. The address labels will appear.  
 
To print volunteer address labels by organization 
Select Organization from the Select Labels By dropdown list. 
Select an organization from the dropdown list of organization names.  
Select a print format and click Display. The address labels will appear.  
 
To print volunteer address labels by service 
Select Service from the Select Labels By dropdown list. 
Select a service from the dropdown list of service names. 
Select a print format and click Display. The address labels will appear.  
 
To print address labels for selected volunteers 
Select Selected Volunteers from the Select Labels By dropdown list. 
Select the volunteer by doing one on the following. 
 

• Enter the first three or more characters of the volunteer's last name in the 
Last Name field and click the List by Name button. 

• Enter the volunteer's social security number in the SSN field and click the 
List by SSN button. 

• Enter the Volunteer's 5-character code in the First Letter/SSN field and click 
the List by Code button.  
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Address Labels, cont. 
 
 
The volunteer's name (or a list of matching entries) will appear in the box. 
If the Get More button is active and you do not see the name you want, click that 
button to see more names. 
Select the volunteer's name from the box and click the Choose button. A new screen 
appears. Select additional volunteers by clicking the Choose Volunteer button and 
repeating the steps. 
Once you have made all your selections, choose a print format and click the Display 
button. The address labels will appear.  
 
To print address labels for all site volunteers 
Select All Volunteers from the Select Labels By dropdown list.  
Select a print format and click Display. The address labels will appear.  
 
To print address labels for all VAVS representatives 
Select All VAVS representatives from the Select Labels By dropdown list. 
Select a print format and click Display. The address labels will appear.  
 
 
Using the browser File menu, select Print to print the address labels. 
Select Save As to save the address list to your hard drive for future use.  
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Daily Volunteer List 
 
 
From this screen you can display an alphabetical list of all station volunteers who 
have logged hours within a specified date range. The report lists the volunteer's 
combination code information and hours logged within the specified time period. 
 
To display the Daily Volunteer List 
 
Select a station or substation in the Select Station field.  
Enter a starting date in the Begin Date field or click Calendar and double-click on a 
date. To display other months in the calendar, click on the arrows at the top left or 
right of the popup window.  
Enter an ending date in the End Date field or click Calendar and double-click on a 
date. To display other months in the calendar, click on the arrows at the top left or 
right of the popup window.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Meal Ticket List/Form 
 
 
This screen allows you to print either a Meal Ticket List or a Volunteer Meal Form. 
The Meal Ticket List contains the names of volunteers who have requested a meal 
when logging in at the auto-login kiosk or who have been added to the list with the 
Edit Meal List screen. It is for Voluntary Services use only.  
 
If the site does not use a meal ticket printer, the Meal Ticket List can be printed as 
a Meal Form. This form can be given to the canteen to authorize volunteers to 
receive a meal on any given day.  
 
To print a Meal Ticket List or Canteen Meal Form 
 
Click a radio button for either Volunteer Meal List or Canteen Form.  
Enter a date in the Select Date field or click the Calendar button and double-click a 
date in the calendar that appears. 
Select a print format. 
Click the Display button. The list/form will appear in a browser window. 
 
To print or save, go to the File menu of the report's browser window and click Print 
or Save As.  
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National Organizations 
 
 
This screen allows you to generate a report of all Voluntary Services national 
organizations. You can select whether to display all national organizations, only 
organizations on the National Advisory Council (NAC), or only organizations not on 
the NAC. 
 
The data displayed in the report includes the organization's code, the month of its 
annual joint review (AJR), and its association with the National Advisory 
Committee (NAC). 
 
To display the Voluntary National Organizations report 
 
For the Select Organizations for Printing option, select which national 
organizations you want displayed. 
 

NAC Only All national organizations represented on the 
 National Advisory Council  
Non-NAC Only All national organizations not represented on 
 the National Advisory Council  
All (NAC and Non-NAC) All national organizations  

 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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New Volunteers 
 
 
With this screen you can display a report of all regularly scheduled volunteers who 
began working in a specified month and year. The report lists the volunteers by the 
organization with which they are associated. Under each organization, the report 
lists the name, ID code, age, entry date, and combination code of each new 
volunteer. 
 
To print a New Volunteers report 
 
Select your station from the Select Station list.  
Select a month and year from the Volunteers Entered in Month Year dropdown list.  
Select the desired print format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  



Voluntary Service Station Menu 

84 Voluntary Service System (VSS) User Manual September 2004 

Reports 
Run Any Time 

Occasional Hours by Date 
 
 
This screen allows you to print a report listing all the occasional hours logged at a 
site within a specified date range. For each of these dates the report lists the 
organization, service, and total hours that were logged by each group of occasional 
volunteers.  
 
The phrase “occasional hours” refers to hours logged by volunteers for whom the site 
has no personal data on record. 
 
To display an Occasional Hours by Date report 
 
Select a station or substation in the Select Station field. 
Select a start date from the Begin Month/Year field.  
Select an end date from the End Month/Year field.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Occasional Hours by Organization 
 
 
This screen allows you to print a report listing all the occasional hours logged at a 
site for specific organizations within a specified date range. The phrase “occasional 
hours” refers to hours logged by volunteers for whom the site has no personal data 
on record. 
 
You can specify one/many/all organizations for which hours were logged within the 
date range. The report supplies totals for each organization for the time period as 
well as grand totals for all organizations.  
 
To display an Occasional Hours by Organization report 
 
Select a station or substation in the Select Station field. 
Select a start date from the Begin Month/Year field.  
Select an end date from the End Month/Year field.  
Highlight an organization (or group of organizations) in the Available Organizations 
box. 
Click the Add button. The highlighted organization(s) will appear in the Selected 
Organizations box. 
To select all listed organizations, click the Add All button. To remove organizations 
that you have selected, highlight them in the Selected Organizations box and click 
the Remove button. To remove all selected organizations, click the Remove All 
button. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu of the report’s browser window and 
select Print or Save As.  
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Occasional Hours by Service 
 
 
This screen allows you to print a report listing all the occasional hours logged at a 
site for specific services within a specified date range. The phrase “occasional hour” 
refers to hours logged by volunteers for whom the site has no personal data on 
record. 
 
The report lists the hours according to the service for which they were performed. 
Each service listing itemizes the hours for each volunteer for each month. It also 
lists totals for each organization as well as a grand total for all organizations in the 
report. 
 
To print an Occasional Hours by Service Report 
 
Select a station or substation in the Select Station field. 
Select a start date from the Begin Month/Year field.  
Select an end date from the End Month/Year field.  
Highlight a service (or group of services) in the Available Services box. 
Click the Add button. The highlighted service(s) will appear in the Selected Services 
box. 
To select all listed services, click the Add All button. To remove services that you 
have selected, highlight them in the Selected Services box and click the Remove 
button. To remove all selected services, click the Remove All button. 
Select a Print Format.  
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu of the report’s browser window and 
select Print or Save As.  
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Potential Termination List VS07 
 
 
From this screen you can display a list of site volunteers who have not logged hours 
since a specified month/year. The list includes name, address, telephone numbers, 
starting date, years served, and total hours of service.  
 
If you specify a date more than 11 months in the past, no names will appear in the 
list as volunteers are automatically terminated after 12 months without hours. 
Those names will then appear in the Terminated Volunteers List (after the monthly 
processing) following the month they are terminated.  
 
To display a Potential Termination List VS07 
 
Select a station or substation in the Select Station field. 
Select a month and year from the Date Since Hours Logged dropdown list. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the report’s browser window and 
select Print or Save As.  
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Regular Scheduled Hours by Organization 
 
 
The Regular Scheduled Hours by Organization screen allows you to print a report of 
regular volunteer hours for selected organizations within a specified time period. 
The report lists the hours logged by volunteers for each organization and month. It 
also lists totals for each organization as well as a grand total for all organizations in 
the report. 
 
To print a Regular Scheduled hours by Organization report 
 
Select a station or substation in the Select Station field. 
Select a start date from the Begin Month/Year field.  
Select an end date from the End Month/Year field.  
Click on the organization(s) in the Available Organizations list you wish to include. 
Click the Add button to move it into the Selected Organizations list. Repeat this 
step for each organization in the list you wish to print.  
To select all organizations, click the Add All button.  
To remove an organization from the Selected Organizations list, highlight it and 
click the Remove button. To remove all your selections from this list, click the 
Remove All button.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the report’s browser window and 
select Print or Save As.  
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Regular Scheduled Hours by Service 
 
 
Using this screen you can display a report listing all the hours logged at a site by 
regular volunteers within a specified date range. Regular volunteers are volunteers 
whose hours are scheduled and whose personal data is on file at the site. 
 
The report lists the hours according to the service for which they were performed. 
Each service listing itemizes the hours for each volunteer for each month. It also 
totals the hours for the service on a monthly basis as well as for the entire date 
range. 
 
To print a Regular Scheduled Hours by Service Report 
 
Select a station or substation in the Select Station field. 
Select a start date from the Begin Month/Year field.  
Select an end date from the End Month/Year field.  
Click on a service(s) in the Available Services list you wish to include. Press the Add 
button to move it into the Selected Services list. Repeat this step for each service in 
the list you wish to print.  
To select all services, press the Add All button.  
To remove a service from the Selected Services list, highlight it and press the 
Remove button. To remove all your selections from this list, press the Remove All 
button.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the report’s browser window and 
select Print or Save As.  
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Sign-In Code List 
 
 
The Volunteer Sign-In Code List screen generates a list of your station’s active 
volunteers and their codes. This may be used in the event a volunteer had forgotten 
their code. 
 
To print a Volunteer Sign-in Code list 
 
Select your station from the Select Station list.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the report’s browser window and 
select Print or Save As.  



  Voluntary Service Station Menu 

September 2004 Voluntary Service System (VSS) User Manual 91 

Reports 
Run Any Time 

Telephone List 
 
 
The Telephone List screen is used to print a list of telephone numbers for station 
volunteers. The volunteer's code is also provided. You have the option of displaying 
either active or terminated volunteers. 
 
To print a Volunteer telephone list 
 
Select your station from the Select Station list.  
Select the radio button to print the list for either Active Volunteers or Terminated 
Volunteers.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the report’s browser window and 
select Print or Save As.  
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Terminated Volunteers 
 
 
This screen allows you to display a report listing all station volunteers terminated 
during a specified month. For each terminated volunteer, the report lists name, 
code, age, entry and termination dates, years served, last award, and total hours 
served. It also states whether the termination was with or without cause. 
 
In most cases, terminations result from no hours logged within a 12 month time 
frame.  
 
To display a Terminated Volunteers Report 
 
Select a station or substation in the Select Station field. 
Select a month from the Volunteers Terminated in Month Year dropdown list. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the report’s browser window and 
select Print or Save As.  
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Volunteer Daily Review 
 
 
This screen allows you to display the hours for a particular volunteer within a 
specified date range. The report lists the dates worked in sequence from oldest to 
most recent. The combination codes and hours are given for each date. It also lists 
the volunteer's total hours for the station and for all stations within the date range.  
 
To print a Volunteer Daily Review report 
 
Select the volunteer by doing one on the following. 
 

• Enter the first three or more characters of the volunteer's last name in the 
Last Name field and click the List by Name button. 

• Enter the volunteer's social security number in the SSN field and click the 
List by SSN button. 

• Enter the Volunteer's 5-character code in the First Letter/SSN field and click 
the List by Code button.  

 
The volunteer's name (or a list of matching entries) will appear in the box. 
If the Get More button is active and you do not see the name you want, click that 
button to see more names. 
Select the volunteer's name from the box and click the Choose button. 
Enter the beginning and ending dates for the report in the Begin Date and the End 
Date fields. To select a date from a calendar, click Calendar and double-click on a 
date.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window. 
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From this screen you can display comprehensive information about all volunteers 
serving your station or its substations. The information includes personal data 
(address, telephone numbers, personal code, and birth date) and service data (years, 
hours, and last award). 
 
To print an alphabetical list of volunteers 
 
Select the station from the Select Station field.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
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Regular Scheduled and Occasional Hours VS01 Part 1 
 
 
This screen allows you to print a report comparing actual and average hours for 
regular and occasional volunteers between two fiscal years. The specified fiscal year 
is compared to the year prior. The data can be restricted to a portion of the fiscal 
year. 
 
The summary format of the report lists the total hours for all services while the 
detailed format lists the individual services. 
 
To display a Voluntary Services RS and Occasional Hours VS01 Part 1 
report 
 
Select a station in the Select Station field. 
Select the desired fiscal year in the Fiscal Year box.  
For the Months option, select the number of months of data you want to include in 
the report.  
Choose to print summary page only, Yes or No. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Regular Scheduled and Occasional Hours VS01 Part 2 
 
 
This screen allows you to print a report of statistics about volunteers at a particular 
station. It compares one period of a given fiscal year with the same period of the 
previous fiscal year.  
 
The first part of this report compares the increase, decrease, and overall change in 
the number of regularly scheduled volunteers at the site. It breaks the data down 
according to sex, student volunteers, volunteers affiliated and unaffiliated with 
organizations, and those recruited and terminated. It also shows the net gain or loss 
in volunteers for the compared time periods. A section is also provided showing the 
hours volunteered.  
 
The second part of the report compares the volunteers in the two fiscal year periods 
by age. It also provides a graph of the age breakdown of volunteers for the 
requested fiscal year. 
 
To display a Voluntary Services RS and Occasional Hours VS01 Part 2 
report 
 
Select a station in the Select Station field. 
Using the dropdown list in the Fiscal Year field, select a fiscal year.  
For the Months option, select the number of months of data you want to include in 
the report.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Volunteers By Organization VS26 
 
 
This screen allows you to display a report showing the number of volunteer hours 
logged for specified organizations during a specified period of a fiscal year. The 
information is listed according to the organization the hours are credited to. It is 
then broken down according to service and month. 
 
For each organization the report lists all active volunteers and whether or not they 
have logged any hours, the totals for number of visits, occasional hours, 
assignments (combinations of organizations, services, and schedules), and the total 
number of adult, youth, and all volunteers contributing hours. 
 
A summary of volunteer hours per organization, without details for individual 
volunteers, is contained in a separate report - the Volunteers By Organization 
Summary VS27 report. 
 
To display a Volunteers by Organization VS26 report 
 
Select a station or substation in the Select Station field. 
Select a date from the Fiscal Year dropdown list.  
For the Months option, select the number of months of data you want to include in 
the report.  
For Show Visits, select No or Yes. Selecting Yes will show not only hours but the 
number of total visits each volunteer made to the station each month.  
Select from the Available Organizations list the organization(s) whose hours you 
wish to view. Click on an organization in the Available Organizations list to 
highlight it. Press the Add button to move it into the Selected Organizations list. 
Repeat this step for each organization in the list you wish to print. To select all 
organizations, click the Add All button. 
To remove an organization from the Selected Organizations list, highlight it and 
click the Remove button. To remove all your selections from this list, click the 
Remove All button.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the menu bar at the top of the 
screen and select Print or Save As.  
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Volunteers By Organization Summary VS27 
 
 
This screen allows you to display a report summarizing volunteer hours during a 
fiscal year. It shows totals for regularly scheduled hours, occasional hours, and all 
hours for each organization during each month. It does not contain any data for 
individual volunteers. Individual volunteer hours are contained in a separate report 
- the Volunteers By Organization VS26 report.  
 
To display a Volunteers by Organization Summary VS27 report 
 
Select a station or substation in the Select Station field. 
Select a date from the Fiscal Year dropdown list.  
For the Months option, select the number of months of data you want to include in 
the report.  
Select from the Available Organizations list the organization(s) whose hours you 
wish to view. Click on an organization in the Available Organizations list to 
highlight it. Click the Add button to move it into the Selected Organizations list. 
Repeat this step for each organization in the list you wish to print. To select all 
organizations, click the Add All button. 
To remove an organization from the Selected Organizations list, highlight it and 
click the Remove button. To remove all your selections from this list, click the 
Remove All button.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the menu bar at the top of the 
screen and select Print or Save As.  
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Volunteers By Using Service VS28 
 
 
This screen allows you to display a report showing the number of volunteer hours 
logged for specified services during a specified period of a fiscal year. The 
information is listed according to the service the hours are attributed to. It is then 
broken down by organization and month. 
 
For each service the report lists all active volunteers and whether or not they have 
logged any hours, totals for age groups, number of visits, occasional hours, and 
assignments (combinations of organizations, services, and schedules), as well as 
adult, youth, and all volunteers contributing hours. 
 
A summary of volunteer hours per service, without details for individual volunteers, 
is contained in a separate report - the Volunteers By Service Summary VS29 report. 
 
To display a Volunteers by Using Service VS28 report 
 
Select a station or substation in the Select Station field. 
Select a date from the Fiscal Year dropdown list.  
For the Months option, select the number of months of data you want to include in 
the report.  
For Show Visits, select No or Yes. Selecting Yes will show not only hours but the 
number of total visits each volunteer made to the station each month.  
Select from the Available Services list the service(s) whose hours you wish to view. 
Click on a service in the Available Services list to highlight it. Click the Add button 
to move it into the Selected Services list. Repeat this step for each service in the list 
you wish to print. To select all services, click the Add All button. 
To remove a service from the Selected Services list, highlight it and click the 
Remove button. To remove all your selections from this list, click the Remove All 
button.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the menu bar at the top of the 
screen and select Print or Save As.  
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Reports 
Monthly Processing 

Volunteers By Using Service Summary VS29 
 
 
This screen allows you to display a report summarizing volunteer hours during a 
fiscal year. It shows totals for regularly scheduled hours, occasional hours, and all 
hours for each service during each month. It does not contain any data for 
individual volunteers. Individual volunteer hours are contained in a separate report 
- the Volunteers By Service VS28 report.  
 
To display a Volunteers by Using Service Summary VS29 report 
 
Select a station or substation in the Select Station field. 
Select a date from the Fiscal Year dropdown list.  
For the Months option, select the number of months of data you want to include in 
the report.  
Select from the Available Services list the organization(s) whose hours you wish to 
view. Click on an organization in the Available Services list to highlight it. Click the 
Add button to move it into the Selected Services list. Repeat this step for each 
service in the list you wish to print. To select all services, click the Add All button. 
To remove a service from the Selected Services list, highlight it and click the 
Remove button. To remove all your selections from this list, click the Remove All 
button.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window. 
 
To print or save the report, go the File menu in the menu bar at the top of the 
screen and select Print or Save As.  
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Reports 
Voluntary Service Directory 

Directory Labels 
 
 
The Voluntary Service Directory Labels screen allows you to print address labels for 
VHA stations. You can print labels for specific stations, for all stations in the 
country, or for all stations in a selected VISN or state. 
 
To print Voluntary Service directory labels 
 
Select a radio button for the Sort Labels By option. 
 

Facility: Select a facility to print labels for that facility only.  
VISN: Select a VISN to print labels for all stations in the VISN.  
State: Select a state to print labels for all stations in the state.  
All Facilities: Allows you to print labels for all VHA facilities. 

 
Select a Print Format.  
Click the Display button. The labels will appear in a browser window. 
To print the labels, go to the File menu of the browser window and select Print. 
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Reports 
Voluntary Service Directory 

Supervised Programs 
 
 
The Voluntary Supervised Program screen allows you to print a report listing all 
Voluntary Services stations running a particular program; for example, Escort 
Service. The report lists the station number, station name, the name of the 
Voluntary Chief, and primary phone number. 
 
To print a Voluntary Supervised Programs list 
 
From the Select Supervised Program list, select a Voluntary program. 
Select a Print Format. 
Click Display. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Service Chiefs 
 
 
The Voluntary Service Chiefs screen allows you to print a list of Chiefs of Voluntary 
Service for all stations. The list includes station name, station number, Voluntary 
Chief name and grade. 
 
To print a list of the Voluntary Service Chiefs 
 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Service Directory 
 
 
This screen allows you to print station information from the Voluntary Service 
Directory. This directory lists information about Voluntary Services at all VHA 
facilities. You can print information for an individual facility, all facilities in the 
country, or all facilities from a selected VISN or state. 
 
Each facility listing contains the following. 
 

• Contact information  
• A list of Voluntary Service programs  
• Staff member names, positions, grades, and start dates 

 
To print a Voluntary Service Directory report 
 
Select a radio button for the Sort Report By option. 
 

Facility: Select a facility to print information for that facility only.  
VISN: Select a VISN to print information for all facilities in that  
 VISN.  
State: Select a state to print information for all facilities in that  
 state.  
All Facilities: Allows you to print information for all VHA facilities. 

 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Station Information Detail 
 
 
From this screen you can display detailed information for a selected station. Some 
of the information provided includes the station's address and phone number, the 
total operating and staff costs, a list of programs, staff names, position titles, e-mail 
addresses, start date, and grade.  
 
To display a Voluntary Station Information Detail report 
 
Select a station from the Select Station dropdown list. 
Select a Print Format. 
Click Display. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Voluntary Service Directory 

Station Information Contact List 
 
 
You can use this screen to display contact information for all Voluntary Service 
stations. For each station the report lists the station name and number, VISN, 
primary phone number, fax number, and name of Voluntary Chief. 
 
To print a Voluntary Station Information Contact list 
 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
Post -FY 

Annual Volunteer List VS30 
 
 
This screen displays a report listing various kinds of information about individual 
volunteers as well as statistical information about the station's regular volunteers 
for a selected fiscal year. The information for each volunteer includes the 
volunteer's codes, birth date, gender, entry and termination dates, hours for current 
year and prior years, and last award data. 
 
The report includes the following totals for the previous year. 
 

• Number of volunteers by sex 
• Number of volunteers by age 
• Number of additions and terminations 
• Station hours for year and prior years 

 
To display an Annual List of Volunteers 
 
Click on the station name(s) in the Select Station(s) field list.  
Select the fiscal year from the Fiscal Year dropdown list. 
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As.  
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Reports 
National Officials 

Labels 
 
 
This screen allows you to print address labels for mailings to national officials. You 
can print labels for officials within the following categories. 
 

• Representatives from specified organizations  
• Deputies from specified organizations  
• National Certifying Officials from specified organizations 
• Specified National Officials  
• Only Reps in Organizations defined as NAC Executive Members  
• All National Officials who are not Reps/Deps/NCOs  

 
The displayed address listing can be saved as a Word file in order to use the 
program's address label utility. 
 
To print labels for national officials 
 
Select the type of official. 
• If you selected Representatives, Deputies, or National Certifying Officials, the 
Available Organizations/Selected Organizations list boxes will appear. If you 
selected All National Officials, the Available Individuals/Selected Individuals list 
boxes will appear. 
Scroll through the Available list and click on the entries you wish to print labels for. 
After each selection, click on the Add button to move the entry into the Selected list 
box. 
To print labels for all listed entries, click the Add All button. 
To remove an entry from the Selected list, highlight it and click the Remove button. 
To remove all entries in the Selected list, click the Remove All button.  
• If you selected the Only Reps in Organizations defined as NAC Executive 
Members or All National Officials not Reps/Deps/NCOs, proceed to the next step.  
From the Number of Labels to Skip list, select the number of labels you want blank 
at the beginning of the list.  
Select a Print Format. Word is usually the best choice for printing. 
Click the Display button. The selected national officials labels will appear.  
To print the address listing select Print from the browser File menu. 
 
To print the labels using Word's label printing utility 
 
Select Save As from the browser menu. Open the saved file in Word. 
Select Envelopes and Labels from the Tools menu. 
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Reports 
National Officials 

Annual Joint Review 
 
 
This screen allows you to print a list of national officials whose Annual Joint 
Review (AJR) with your site is scheduled for a specified month. This list is arranged 
alphabetically by national organization name and provides the official's name, title, 
telephone number, and date appointed. 
 
To print an Annual Joint Review list 
 
Select a month from the Annual Joint Review Month dropdown list.  
Select a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report’s browser window and 
select Print or Save As.  
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Reports 
National Officials 

National Officials Data View 
 
 
From this screen you can display a data view of all national officials’ information. 
Some of the data elements provided include name, ID, telephone number and 
address, title, organization code, AJR (annual joint review) month, whether the 
organization is a NAC Executive member, date appointed, and whether the official 
is in the NCO.  
 
A data view presents all the data in a database table. There is too much data in the 
data view to fit into a normal page for printing, so you will probably want to save it 
to your hard drive and then open it in Excel or Word; or you can import the saved 
file to a database program, such as Quicken or Access. At that point, you can delete 
portions of it, add to it, rearrange it, sort it, reformat it, and/or insert it into other 
applications. 
 
To display a Voluntary National Officials Data View 
 
Click Display. The Voluntary National Officials Data View will appear.  
 
To save a Voluntary National Officials Data View as an Excel or Word file 
 
Select Save As from the Internet Explorer browser File menu.  
In the Save Web Page dialog box do the following:  
In the Save In dropdown list at the top, browse to a drive and directory to store the 
data view. 
In the Filename dropdown list at the bottom, enter a filename for the data view.  
In the Save as type dropdown list, select Web Page, complete or Web Page, HTML 
only.  
Click the Save button.  
 
To open the data view 
 
Open Excel or Word  
Open the data view file from the File menu.  
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Awards Menu 
Awards Coding 

 
 
From the Awards Coding screen you can display a list of volunteers who have 
served enough hours to be eligible for an award. For each volunteer, the list shows 
total hours and years of service, date and hours of the last award, and the name of 
the award for which the volunteer is eligible. By default, all volunteers eligible for 
an award will receive it. But, if for some reason, (e.g., termination or death) you do 
not want the volunteer to be processed to receive the award, they can be excluded 
using this screen.  
 
There is no way to recall an award once you have posted this screen. You can, 
however, post it again to process volunteers previously excluded from an award. 
 
The same volunteers listed in the Potential Awards Report will appear in this 
option with the exception of the Hours and Years Award.  The Hours and Years 
Award is not processed in VSS.  
 
The Awards Coding screen is the second step in the VSS awards management 
process. The three steps are as follows. 
 

1) Use the Potential Awards Report screen to print and review the Potential 
Awards Listing. 

2) Use the Awards Coding screen to process eligible volunteers to receive their 
awards. 

3) Use the Awards Processed Report screen to print address labels for mailing 
invitations to the awards banquet or to print the list of all volunteers who 
will receive awards at the next awards banquet. 

 
To display and process a list of volunteers eligible for an award 
 
From the Date of Award list, select a cutoff date. Hours served after this date will 
not count toward award eligibility at the next awards ceremony.  
For Include, select an age category radio button: Adult, Youth, or Both.  
For Show Terminated, select Yes to include terminated volunteers in the Awards 
Coding list; otherwise select No.  
Click the Display button. 
If there are any volunteers in the list that should not receive awards, click on their 
Give Awards checkbox in the far right-hand column. By default the checkbox is 
checked; unchecking it will prevent the volunteer from receiving the award. When 
you are ready to submit the entire list, click on the Post Awards button. 
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Awards Menu 
Awards Processed Report 

 
 
Using this screen you can print a report listing all volunteers who have been 
processed to receive awards at the next awards banquet or address labels for all 
volunteers processed to receive awards at the next awards banquet 
 
The Awards Processed Report lists, in alphabetical order, all volunteers processed 
to receive each award. It lists the volunteer's name, identifying code, organization, 
organization code, years at the station, and date and hours of last award. The report 
also indicates (with an asterisk) any volunteers who have been terminated.  
 
Sites can choose to print labels from both the Potential Awards Report and the 
Awards Processed Report. If a site chooses to print the labels from the Potential 
Awards Report, the labels will be printed prior to the award being processed in VSS 
(using the Award Coding option). This also means that labels for the Hours and 
Years Award are also printed. If a site chooses to print the labels from the Awards 
Processed Report, the labels will be printed after the award is processed in VSS. 
You cannot print the Hours and Years Award labels from the Awards Processed 
Report since this award is not processed in VSS. Once awards have been processed 
in VSS, they will be removed from the Potential Awards Report and will show up 
under the Awards Processed Report. 
 
The Awards Processed Report screen is the third step in the VSS awards 
management process. The three steps are as follows. 
 

1. Use the Potential Awards Report screen to print and review the Potential 
Awards Listing. 

2. Use the Awards Coding screen to process eligible volunteers to receive their 
awards. 

3. Use the Awards Processed Report screen to print the Awards Processed 
Report (the final list of all volunteers who will receive awards at the next 
awards banquet) and the mailing address labels. 
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Awards Menu 
Awards Processed Report, cont. 

 
 
To print address labels or a report of volunteers processed to receive 
awards 
 
Click on your station name in the Select Station box.  
For Begin Date and End Date, enter a date range for the awards. You can use the 
Calendar buttons or highlight the date in the date box and type in the desired date.  
To print the Award Processed Report, click No for Print Labels. To print the address 
labels, click Yes for Print Labels. 
Choose a Print Format. 
Click the Display button. The report/labels will appear in a browser window. 
 
To print or save, go to the File menu of the browser window and select Print or Save 
As. 
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Awards Menu 
Potential Awards Report 

 
 
This screen allows you to print a list of volunteers who have reached the hours of 
service required to receive an award. The report is organized by award category. It 
lists each volunteer eligible for each award in alphabetical order.  
 
The Potential Award report lists the organization(s) that each volunteer is affiliated 
with, the volunteer's current total hours and years of service, and the date and 
number of hours for the volunteer's last award. You can choose to list adult 
volunteers only, youth only, or both.  
 
Sites can choose to print labels from both the Potential Awards Report and the 
Awards Processed Report. If a site chooses to print the labels from the Potential 
Awards Report, the labels will be printed prior to the award being processed in VSS 
(using the Award Coding option). This means that labels for the Hours and Years 
Award are also printed. If a site chooses to print the labels from the Awards 
Processed Report, the labels will be printed after the award is processed in VSS. 
You cannot print the Hours and Years Award labels from the Awards Processed 
Report since this award is not processed in VSS. Once awards have been processed 
in VSS, they will be removed from the Potential Awards Report and will show up 
under the Awards Processed Report. 
 
The Potential Awards Report screen is the first step in the VSS awards 
management process. The three steps are as follows. 
 

1. Use the Potential Awards Report screen to print and review the Potential 
Awards Listing. 

2. Use the Awards Coding screen to process eligible volunteers to receive their 
awards. 

3. Use the Awards Processed Report screen to print the Awards Processed 
Report (the final list of all volunteers who will receive awards at the next 
awards banquet) and the address labels. 
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Awards Menu 
Potential Awards Report, cont. 

 
 
To display a Potential Awards report 
 
Select a station in the Select Station field. 
Select the end date for the award from the End Date of Award dropdown list. 
Click one of the Include radio buttons to select an age category; adult, youth, or 
both. 
If you want terminated volunteers to be noted on the report, click Yes for Show 
Terminated. Terminated employees are indicated on the report by an asterisk. 
Choose to print labels, Yes or No. 
Select a Print Format. 
Click the Display button. The report/labels will appear in a browser window. 
 
To print or save, go to the File menu of the browser window and select Print or Save 
As. 
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Maintenance 
Site Parameters 

 
 
This screen is used by the site manager to define the auto-login settings and 
greeting. The settings on this screen should be modified immediately after the site 
is migrated to VSS. For the auto-login process to work properly, the meal and 
language options must be set. 
 
Complete the Meal Ticket Settings 
 

Meal Price  Dollar amount that the station will pay for a single meal, i.e., 5.25 

Number of Meals Number of meals the site will allow volunteers. 

Required hours for 1 Meal 
Number of hours a volunteer must work to receive one meal. If the 
number of specified meals is two, two Required Hours fields will 
appear, one for each meal. 

Cut off time for 1 meal 

The hour a volunteer must log in by to receive the meal. This must 
be a four-digit, military-time number. For example, for 2 PM you 
would enter 1400. If the number of specified meals is two, two Cut 
off time fields will appear, one for each meal. 

Meals Allowed on Days To make meals available on any or all of these days, check the 
appropriate boxes. 

Meal Authorization Type The meal authorization process used at your site; canteen form or 
meal ticket.  

 
Complete the Auto-Login Language Settings. 
 

Default Language The language for the auto-login screens.   

Require Alternate Language 

Two languages can appear on the auto-login screens, the default 
and an alternate. Currently, Spanish is the only alternate language 
available. If Yes is checked, the Alternate Language dropdown list 
will appear. 

Alternate Language  

Two languages can appear on the auto-login screens, the default 
and an alternate. Currently, Spanish is the only alternate language 
available. The alternate language setting will only take effect if the 
Require Alternate Language checkbox is checked.  

 
Complete the Auto-Login Introduction, if necessary. Use this text box to record any 
messages you want displayed to volunteers when they log in at the auto-login kiosk. 
 
Click the Post button to activate the selections. If you want to exit without 
activating the selections, click the Exit button.  
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Maintenance 
Programs 

 
 
Each VHA facility has special programs, such as the Reception Desk or Escort 
Service, that can be administered by Voluntary Services. Voluntary Service 
programs can either be local to a particular station or national. This screen allows 
you to create a new, local station program. Each locally created program requires a 
name and code.  
 
Although you can use the Programs screen to view the name and code for both local 
and national Voluntary Services programs at your station, you can edit only local 
programs. National programs are maintained by Central Office. 
 
To add a new local program 
 
Click the New button.  
Enter a new service code in the Code field. The code must be three digits, within the 
range of 100 to 999.  
Enter a name for the program (up to 30 characters) in the Program Name field. 
Click the Post button. "Record Posted!" displays at the top of the screen.  
 
To edit an existing local program 
Note: You can only edit locally created programs from this screen.  
 
Select a program from the Edit an Existing Program Code box. 
Click the Edit button. Information for the selected program populates the fields. 
Edit the fields as needed.  
Click the Post button. "Record Posted!" displays at the top of the screen. 
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Maintenance 
Voluntary Services 

 
 
The Voluntary Services screen allows you to perform three general tasks. 
 
1.  Edit station-specific Voluntary Services information. 
 
The Voluntary Services information entered here is basic station information that 
appears in several reports.  
 

Service Title The voluntary service station name. Up to 30 characters.  

Primary Phone Full phone number, with area code and extension. Up to 
30 characters. 

Fax number Full fax number, with area code. Up to 30 characters. 

Mail Stop Code Up to 6 characters. 

Alternate Phone Secondary phone number. Up to 30 characters.  

Chief's 
Immediate 
Supervisor 

Up to 30 characters. 

Operating Costs 
The total Voluntary Services budget for the station, 
based on the previous fiscal year. A dollar amount, up to 
11 digits. No commas or decimal points. 

VAVS 
Committee 

Is the station a Veterans Affairs Voluntary Service 
committee member? If yes, check the Yes box. 

Service Type How Voluntary Services is classified within the medical 
facility: a program, service, or section.  

Staff Costs 
Total yearly benefits and salary for Voluntary Services. A 
dollar amount, up to 11 digits. No commas or decimal 
points. 

VAVS 
Information 
Last Reviewed 

The date the station had its last VAVS review. Date 
automatically entered when the Update Last Reviewed 
Date box is checked.  

Update Last 
Reviewed Date 

Check this box when the VAVS review occurs. It will 
update the VAVS Information Last Reviewed field. 
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Maintenance 
Voluntary Services, cont. 

 
 
2.  Maintain the list of programs administered by Voluntary Services. These 
programs can be local or national. 
 
To add a program to the Supervised Programs list 
 
Select a program from the Select Program dropdown list. 
Click the Add button. The selected program will appear in the Supervised Programs 
list. Click the Post button. 
 
To delete a program from the Supervised Programs list 
 
Click the Delete button next to the program in the Supervised Programs list. Click 
the Post button. 
 
 
3.  Add/edit/delete the master record for a Voluntary Service staff person. 
 
Click the Service Staff button at the bottom of the screen. The Service Staff screen 
will appear. You can create, edit, or delete master records for Voluntary staff 
members using this screen. If the new staff person is a VSS user, he or she can be 
selected and the record data will be inserted automatically. If the new staff person 
is a Voluntary program member, and therefore not a system user, you must add the 
master record information field by field.  
 
If you are adding a Voluntary Services program member who will also be a VSS 
user, you should first add them as a user via the User Management screen. 
Likewise, removing them as staff members using the Service Staff screen will not 
remove them from the VSS system. You should remove the staff member first 
through the User Management screen.  
 
When you have finished editing, click the Service Information button at the bottom 
of the Service Staff screen if you wish to return to the Voluntary Services screen.  
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Maintenance 
Voluntary Services, cont. 

 
 
To add a staff member master record 
 
Click the Service Staff button at the bottom of the screen. The Service Staff screen 
will appear. To add a Voluntary staff person who does not have an NT username do 
the following. 
 
Click the New button. 
If the member is a user on the VSS system, select the member's name from the 
Select Existing User to Add dropdown list. If the member is not an existing user, 
click the Create button. 
Enter/edit the requested information into the Staff Master Record fields. 
Use the Insert after Row dropdown list to determine where in the Service Staff 
table at the top of the screen the new record will go.  
Use the Program dropdown list to select the Voluntary program the new staff 
person is associated with. If they are not in a special program, select Voluntary 
Service. 
Click Post to enter the new master record into the database.  
The name of the new staff person will appear in the Service Staff table. 
 
To edit a staff member master record 
 
Locate the record you want to edit in the Service Staff table at the top of the screen 
and click Edit. The Staff Master Record fields will populate with the staff member's 
master record data. 
Enter/edit the requested information into the Staff Master Record fields. 
Click Post to enter the edited master record into the database.  
"Record Posted" will appear below the Service Staff table. 
 
To delete a staff member master record 
 
Locate the record you want to delete in the Service Staff table at the top of the 
screen and click Remove.  
The staff member's record will disappear from the Service Staff table. 
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Maintenance 
Organization Codes 

 
 
Stations can have relationships with both national organizations (maintained by 
Central Office) or local organizations (maintained by the station). This screen 
allows you to create or edit information for local organizations that station 
volunteers can credit hours to. It is important to note that stations and substations 
maintain separate local organizations. 
 
The information entered for each new organization includes code, name, and an 
optional abbreviation for the name. Though you can view the information for any of 
the station's affiliated organizations, you can edit it only if the organization is local. 
 
To add a local Organization Code 
 
Click New.  
Type a three digit code between 900 and 999 in the Organization Code field. 
Enter the name of the new organization (up to 30 characters) in the Name of 
Organization field.  
(Optional) Enter an abbreviation for the new organization (up to 6 characters) in 
the Abbreviation field. 
Check the Inactive field to make the organization unavailable to credit hours to. 
Click Post.  
"Record Posted!" displays at the top of the screen. 
 
To edit a local Organization Code 
 
Select the desired organization code from the pulldown list in the Edit an Existing 
Organization Code field. Click Edit. The selected organization code information 
populates the screen's fields. 
Edit the fields as needed.  
Check the Inactive field to make the organization unavailable to credit hours to. 
Click Post.  
"Record Posted!" displays at the top of the screen. 
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Maintenance 
Service Codes 

 
 
A service can either be national or local to a particular station. This screen allows 
you to add or edit information for a local station service. After posting this 
information, the new service becomes available to both regular and occasional 
volunteers and can be included in regular volunteer combination codes. The 
information for each service may include service code, name, abbreviation, and 
subdivision. 
 
Although you can view information for any service, you can edit it only if the service 
is local. Central Office maintains national codes. 
 
To add a new local service 
 
Click New. The next available unused service code number appears automatically 
in the Service Code field. If you want to enter your own service code, you can. 
Highlight the code in the Service Code field and type in your own. The code must be 
three digits, within the range of 800 to 899. An optional uppercase alpha character 
can follow it (example: 825B). 
Enter the name of the service (up to 22 characters) in the Name of Service field. 
(Optional) Enter an abbreviation for the service (up to seven characters) in the 
Abbreviation field.  
(Optional) Enter the service subdivision (up to 12 characters) in the Subdivision 
field.  
Click Post. "Record Posted!" displays at the top of the screen. 
 
To edit an existing local service 
 
Select the service from the Edit an existing Service Code field. If the service code 
has a subdivision, the service name will be followed by a hyphen and the 
subdivision. Click Edit.  
Information for the selected service populates the screen's fields. 
Edit the fields as needed. 
Click Post. "Record Posted!" displays at the top of the screen. 
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Maintenance 
Edit Meals 

 
 
From this screen you can add a volunteer to receive a daily meal. You might need to 
do this under the following circumstances. 
 

• An unscheduled volunteer requests a meal  
• Your site uses the Volunteer Meal Form to authorize meals instead of issuing 

meal tickets  
• An auto-login kiosk malfunction is preventing volunteers from printing meal 

tickets for themselves 
 
If your site has a meal ticket printer, you can print a meal ticket from this screen. 
The Meal List at the bottom of this screen automatically lists all volunteers who 
have logged in on the current date and requested a meal ticket. It also lists all 
volunteers entered manually by Voluntary Services staff using this screen. This list 
can also be printed from the Run Any Time Report, Meal Ticket/ List Form screen. 
That screen has an option for printing the list as a Volunteer Meal Form at sites 
without meal ticket printers.  
 
The Unscheduled column of the Meal List shows volunteers entitled to receive a 
meal that do not appear in the VSS database as regularly scheduled volunteers. 
(Site staff determines who qualifies to receive an unscheduled meal.) This list can 
be used to grant meals to occasional volunteers or walk-ins, substituting for 
manually written tickets. 
 
The Reprint column in the Meal List lists Yes for volunteers whose meal tickets 
have been requested twice (due to auto-login malfunctions, for example).  
 
To add a regularly scheduled volunteer to the daily meal list 
 
Enter at least the first three letters of the volunteer's last name in the Add 
Volunteer Last Name field. Click the Choose button. 
If there is only one name in the database starting with those letters that name will 
automatically appear in the field Add Volunteer Last Name field.  
The Select Volunteer dropdown list will appear if there is more than one volunteer 
at the site whose name starts with that sequence of letters. If so, select the full 
name from the list. It will now appear in the Add Volunteer Last Name field. 
Click the Add button. The volunteer's name will appear in the Meal List. 
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Maintenance 
Edit Meals, cont. 

 
 
NOTE:  If you see the message,”Volunteer has been Terminated, no actions 
allowed”, you will need to get permission from the Voluntary Services staff to add 
the volunteer as an unscheduled volunteer. 
 
To add an unscheduled volunteer to the daily meal list 
 
Type the volunteer's name (last name first) in the Unscheduled Volunteer field. If 
that field is not available, click Clear to make it appear.  
Click the Add button. The volunteer's name will appear in the Meal List.  
 
To delete a volunteer from the daily meal list 
 
Click the Delete button to the right of the volunteer's name.  
 
To print a meal ticket using the daily meal list 
 
Click the Print button to the left of the volunteer's name. The print option is only 
available for regularly scheduled volunteers.  
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Maintenance 
Affiliated Organizations 

 
 
This screen allows you to add to or delete from the station's Current Affiliated 
Organizations list. This list informs Central Office which organizations are 
affiliated with your station. An affiliated organization is a national Voluntary 
Services organization that a station chooses to have a relationship with. This 
relationship can include the following. 
 

• The ability to assign volunteer hours to the organization 
• Representation at annual VAVS Advisory Committee meetings through a 

national official  
• An Annual Joint Review between the station chief and local organization 

representative 
 
To add an affiliated organization to the station's Current Affiliated 
Organizations list 
 
Select the desired organization name/code from the Organization dropdown list. 
Click Add. 
The selected organization will appear in the Current Affiliated Organizations list 
and the message "Record Added!" will display at the top of the screen. 
 
To delete an affiliated organization from the station's Current Affiliated 
Organizations list 
 
Click Delete next to the organization name in the Current Affiliated Organizations 
list. The organization name is removed from the list and the message "Record 
Deleted!" will display at the top of the screen. 
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User Administration 
User Management 

 
 
The User Management screen can only be accessed by the site administrator. The 
administrator uses this screen to assign roles to site users. The role determines 
what data the user will have access to. 
 
The term “user” refers to Voluntary staff members, not volunteers. Volunteers are 
administered through the Add Volunteers and Edit Volunteers screens. 
 
Once you assign a new primary station to a user, only the user administrator at the 
new station can edit that user's personal data. Roles, however, can still be added 
and removed.  
 
To create a new Voluntary Service user in the VSS System 
 
Enter the information for the following fields. 
 

Last Name, First Name, Middle Name or Initials 
NT User Name - Enter the domain name followed by a back slash and then the 
full NT user name. (Example: VHAMASTER\VHAAREALASTNAMEF) 
E-mail Address 
 

Select your site's name from the Primary Station dropdown list.  
 
Highlight one of the roles listed in the Roles box and click the right arrows to assign 
it to the new user. The assigned role will appear in the Current Roles box. You can 
repeat this step to assign more than one role to a single user. If you make a 
mistake, highlight the role you want to delete in the Current Roles box and click the 
left arrows. The role will disappear from the Current Roles box.  
 
When all of the information appears correct, click the Post button to enter it into the 
database.  
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User Administration 
User Management, cont. 

 
 
To change/add/delete a role for an existing user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information.  
Highlight the desired role(s) and use the right and left arrows to assign/unassign 
the role(s). 
When you are satisfied with the user's role assignment(s), click the Post button to 
enter the change into the database.  
 
To change the primary station for a user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information. Click the Back button on the browser window. 
Select the user's new primary station from the Primary Station dropdown list. 
Click the Post button to enter the change into the database.  



Voluntary Service Station Menu 

128 Voluntary Service System (VSS) User Manual September 2004 

User Administration 
User Reports 

 
 
You can use this screen to display computer system information for each VSS staff 
person at your station. This information includes domain and user name, E-mail 
address, and VSS role. The VSS role determines the screens to which the user has 
access. The report can be sorted by either user role or name. 
 
To display a user report 
 
Select your station from the Select Division field. 
Select either User or Role for the Group by option.  
Select the desired print format. 
Click Display. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As. 



  Voluntary Service Station Menu 

September 2004 Voluntary Service System (VSS) User Manual 129 

Donations 
Donations Reports 

Donations Data View 
 
 
From this screen you can display a data view of all donations information for a 
station. The Donations Data View lists all data collected for every donation made to 
the station. This includes the institution code, donor ID, donation type, description, 
dollar value, donor name and address, donor affiliation, acknowledgment date, 
General Post Fund number, and field service receipt number.  
 
A data view presents all the data in a database table. There is too much data in the 
data view to fit into a normal page for printing, so you will probably want to save it 
to your hard drive and then open it in Excel or Word; or you can import the saved 
file to a database program, such as Quicken or Access. At that point, you can delete 
portions of it, add to it, rearrange it, sort it, reformat it, and/or insert it into other 
applications as you see fit.  
 
To display a Voluntary Donations Data View 
 
Click Display. The Voluntary Donations Data View will appear.  
 
To save a Voluntary Donations Data View as an Excel or Word file 
 
Select Save As from the Internet Explorer browser File menu.  
In the Save Web Page dialog box do the following:  
In the Save In dropdown list at the top, browse to a drive and directory to store the 
data view. 
In the Filename dropdown list at the bottom, enter a filename for the data view.  
In the Save as type dropdown list, select Web Page, complete or Web Page, HTML 
only.  
Click the Save button.  
 
To open the data view 
 
Open Excel or Word  
Open the data view file from the File menu.  
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Donations 
Donations Reports 

Generate Memo 
 
 
This screen allows you to print a record of a donation in the form of a memo to the 
station Chief of Voluntary Services. The Record of Donations Memo lists the 
donation date, type, value, check number, and check date, and provides space for 
the signature of the Voluntary staff person receiving the donation.  
 
This screen is used for notification and record-keeping purposes within Voluntary 
Services after recording a donation using the Add/Edit Donations screen. The 
Donations Receipt screen should be used to print a receipt for the donor.  
 
To print a Record of Donations Memo 
 
Enter a date in the Select Date field or click the Calendar button and click on a date 
in the popup calendar. To move the month forward or backward, click on the arrows 
on either side of the month, at the top of the calendar.  
Any donations recorded on the specified date will be listed in the Select Donation 
box. Click on the desired donation in the Select Donation box.  
Select a Print Format and click Display.  
When the Memo form appears, select Print from the browser File menu.  
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Donations 
Donations Reports 

Generate Receipt 
 
 
When a new donation is received by Voluntary Services, VAVS requires that a 
receipt for the donation be given to the donor. This receipt is VA Form 10-2815, 
Temporary Receipt for Funds. The receipt lists the form of donation, GPF, check 
number, amount, description of donation, reference, and date. The Receipt includes 
spaces for the signatures of the Voluntary staff issuing the receipt and accepting the 
donation.  
 
To print a Temporary Receipt for Funds 
 
Enter a date in the Select Date field or click the Calendar button and click on a date 
in the popup calendar. To move the month forward or backward, click on the arrows 
on either side of the month, at the top of the calendar.  
Any donations recorded on the specified date will be listed in the Select Donation 
box. Click on the desired donation in the Select Donation box.  
Select a Print Format and click Display.  
When the Receipt form appears, select Print from the browser File menu.  



Voluntary Service Station Menu 

132 Voluntary Service System (VSS) User Manual September 2004 

Donations 
Donations Reports 

Total Donations By Station 
 
 
This screen generates a comparison report showing total monetary and material 
donations for a specified station. It lists the information for the specified fiscal year, 
as well as the previous three fiscal years.  
 
To print a Total Donations By Station report 
 
Select a station from the Select Station list.  
Select the year from the Fiscal Year dropdown list.  
Select the desired Print Format. 
Click Display. The report will appear in a browser window.  
 
To print the report or save the report, go to the File menu and select Print or Save 
As.  
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Donations 
Add/Edit Donation 

 
 
The Add/Edit Donations screens allow you record donations made to Voluntary 
Services. Information concerning a donation is associated with the donor; so when 
entering a new donation or changing the details of a previous one, the donor 
information is selected or entered first.  
 
The screen contains a sort feature which allows you to look up donations by date, 
last name of donor, organization, affiliation, or donation value. The sorted records 
will appear in a table in the middle of the screen. 
 
You can choose to print a Record of Donations Memo. This memo lists the donation 
date, type, value, check number, and check date, and provides space for the 
signature of the Voluntary staff person receiving the donation. 
 
You can also choose to print a Temporary Receipt for Funds. This is issued to the 
donor when a new donation is received by Voluntary Services and is a VAVS 
requirement. The receipt lists the form of donation, GPF, check number, amount, 
description of donation, reference, and date. The receipt includes spaces for the 
signatures of the Voluntary staff issuing the receipt and accepting the donation.  
 
To enter a donation for a new donor 
 
Click the Create New Donor|Donation button. 
Select the Donor Type from the dropdown list (donor type definitions are as follows). 
Then complete the Donor information fields. 
 
Individual - Individual donates with no organization or company affiliation. 
 
Individual and Organization - Individual donating is associated with or represents a local 
or national organization with a Voluntary Services code. The donation is associated with 
both the individual and the organization.  
 
Individual and Affiliation - Individual donating is associated with or represents a business 
entity. This business entity cannot be a local or national Voluntary Services organization. 
The donation is associated with both the individual and the affiliated business. 
 
Organization - Representative from a national or local Voluntary Services organization 
makes a donation on behalf of that organization. The organization alone is the donor. 
 
Affiliation - Representative of a business entity makes a donation on behalf of that 
business. The business entity alone is the donor. 
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Donations 
Add/Edit Donation, cont. 

 
 
Enter the Donation Date and select the Donation Type from the dropdown list. 
Then complete the remaining Donation information fields.  An explanation of some 
fields is provided below. 
 
Reference Free-text field for categorizing donations, such as division ID or sub-accounts. 

General Post Fund General Post Fund account number that the donation has been applied to. 
Required for monetary donations.  

Field Service 
Receipt 

Receipt number from Fiscal Service once a donation has been submitted and 
recorded ( e.g. VA form 10-0368 Automated Field Service Receipt number 
received). 

Value Amount of monetary donation or the estimated value of a non-monetary 
donation. 

Designation Purpose or intended recipient of the donation. 

Salutation Any words the donor wants to add with the donation.  

Acknowledgment 
Date 

Date the Voluntary Services letter of acknowledgment was sent to the donor. 
Entered after the donation.  

Local Branch Free text field for recording the local branch name of a Voluntary Services 
national organization. Previously termed "PostUnitChapter" in VistA.  

 
Click the Post button to record your entry. 
Click the Print button if you wish to print a receipt or memo for the new donation. 
The Donation Print screen appears. 
To print a Temporary Receipt for Funds, click the Receipt radio button. To print a 
Record of Donations Memo, click the Memo radio button. 
Choose a Print Format. Click Display if you wish to see the receipt or memo as it 
will be printed. 
Select Print or Save As in the browser to print/save the receipt or memo. 
Click Exit to return to the Add|Edit Donations screen.  
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Donations 
Add/Edit Donation, cont. 

 
 
To enter a new donation for an existing donor 
 
Select a search method from the Sort by dropdown list and fill in the "for" field. 
Click the Sort button. The results of the sort appear in a table in the center of the 
screen.  
Click the Add Donation button for a donation in the table belonging to the donor. If 
the list is long, you can use the Next and Previous buttons to navigate through the 
list.  
Enter the information requested in the fields in the Donations section of the screen. 
The Donor section will already be filled in. You can edit this information if 
necessary. 
Click the Post button to record your entry. 
Click the Print button if you wish to print a receipt or memo for the new donation. 
The Donation Print screen appears. 
To print a Temporary Receipt for Funds, click the Receipt radio button. To print a 
Record of Donations Memo, click the Memo radio button. 
Choose a Print Format. Click Display if you wish to see the receipt or memo as it 
will be printed. 
Select Print or Save As in the browser to print/save the receipt or memo. 
Click Exit to return to the Add|Edit Donations screen.  
 
To edit or view information on an existing donor or donation 
 
Select a search method from the Sort by dropdown list and fill in the "for" field. 
Click the Sort button. The results of the sort appear in a table in the center of the 
screen.  
Click the Edit button for the desired donor/donation. View or edit the fields as 
desired. 
Click the Post button to record any changes you made.  
Click the Print button if you wish to print a receipt or memo for the new donation. 
The Donation Print screen appears. 
To print a Temporary Receipt for Funds, click the Receipt radio button. To print a 
Record of Donations Memo, click the Memo radio button. 
Choose a Print Format. Click Display if you wish to see the receipt or memo as it 
will be printed. 
Select Print or Save As in the browser to print/save the receipt or memo. 
Click Exit to return to the Add|Edit Donations screen.  
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User Administration 
User Management 

 
 
The User Management screen can only be accessed by the site administrator. The 
administrator uses this screen to assign roles to site users. The role determines 
what data the user will have access to. 
 
The term “user” refers to Voluntary staff members, not volunteers. Volunteers are 
administered through the Add Volunteers and Edit Volunteers screens. 
 
Once you assign a new primary station to a user, only the user administrator at the 
new station can edit that user's personal data. Roles, however, can still be added 
and removed.  
 
To create a new Voluntary Service user in the VSS System 
 
Enter the information for the following fields. 
 

Last Name, First Name, Middle Name or Initials 
NT User Name - Enter the domain name followed by a back slash and then the 
full NT user name. (Example: VHAMASTER\VHAAREALASTNAMEF) 
E-mail Address 
 

Select your site's name from the Primary Station dropdown list.  
 
Highlight one of the roles listed in the Roles box and click the right arrows to assign 
it to the new user. The assigned role will appear in the Current Roles box. You can 
repeat this step to assign more than one role to a single user. If you make a 
mistake, highlight the role you want to delete in the Current Roles box and click the 
left arrows. The role will disappear from the Current Roles box.  
 
When all of the information appears correct, click the Post button to enter it into the 
database.  
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User Administration 
User Management, cont. 

 
 
To change/add/delete a role for an existing user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information.  
Highlight the desired role(s) and use the right and left arrows to assign/unassign 
the role(s). 
When you are satisfied with the user's role assignment(s), click the Post button to 
enter the change into the database.  
 
To change the primary station for a user 
 
Select the user from the Edit an Existing User dropdown list. The fields will 
populate with the user's information. Click the Back button on the browser window. 
Select the user's new primary station from the Primary Station dropdown list. 
Click the Post button to enter the change into the database.  
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User Administration 
User Reports 

 
 
You can use this screen to display computer system information for each VSS staff 
person at your station. This information includes domain and user name, E-mail 
address, and VSS role. The VSS role determines the screens to which the user has 
access. The report can be sorted by either user role or name. 
 
To display a user report 
 
Select your station from the Select Division field. 
Select either User or Role for the Group by option.  
Select the desired print format. 
Click Display. The report will appear in a browser window.  
 
To print or save the report, go to the File menu of the report's browser window and 
click Print or Save As. 
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Games 
Games Reports 

Address Labels (Games) 
 
 
You can use this screen to print address labels for registered Games volunteers 
associated with a selected Games. You can select the labels to print by age range, 
organization, or service. You can also specify a particular volunteer, all volunteers, 
or all volunteers who are VAVS representatives.  
 
Highlight the desired games in the Select Game box.  
 
Address labels by age range 
Select Age Range from the Select Labels By dropdown list. 
Select a beginning age from the From list and an ending age from the To list.  
Select a print format and click Display. The address labels will appear.  
 
Address labels by organization 
Select Organization from the Select Labels By dropdown list. 
Select an organization from the dropdown list of organization names.  
Select a print format and click Display. The address labels will appear.  
 
Address labels by service 
Select Service from the Select Labels By dropdown list. 
Select a service from the dropdown list of service names. 
Select a print format and click Display. The address labels will appear.  
 
Address labels for a specific volunteer 
Select Selected Volunteers from the Select Labels By dropdown list.  
A list of current registered volunteers for the selected Games will appear. If you 
wish to search the list you can do so by name, SSN, or station. Select your preferred 
search method, enter the appropriate value in the “for” box, and click the Search 
button. 
Once you have the desired entry, click the Display button next to the volunteer’s 
name to display the address label. 
 
Address labels for all site volunteers 
Select All Volunteers from the Select Labels By dropdown list.  
Select a print format and click Display. The address labels will appear.  
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Games 
Games Reports 

Address Labels (Games), cont. 
 
 
Address labels for all VAVS representatives 
Select All VAVS representatives from the Select Labels By dropdown list. 
Select a print format and click Display. The address labels will appear.  
 
To print the address labels 
Using the browser File menu, select Print to print the address labels. 
Select Save As to save the address list to your hard drive for future use.  
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Games 
Games Reports 

Daily Work Schedule 
 
 
Using this screen you can display a report listing all Games volunteers working on 
specified days of the week. For each day specified the report lists the following. 
 

• all scheduled volunteers  
• each volunteer's pseudo code (first initial followed by last four SSN digits)  
• all available workday codes  
• each volunteer's service code and service name 

 
To display a Daily Work Schedule for Games volunteers 
 
Highlight the desired Game in the Select Game box.  
Check the appropriate Select Days check boxes to specify the days of the week to 
display.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Use Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Master Registration List 
 
 
This screen lets you display an alphabetical list of all registered volunteers for a 
specified Game. For each volunteer listed, the report shows a volunteer pseudo code 
and a combination code assignment.  
 
To display a Master Registration list 
 
Highlight the desired Game in the Select Game box.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Organization Regular Scheduled Hours 
 
 
Using this screen, you can display a report listing data on Games volunteers and 
their hours of service for specified Games organizations. The report may be printed 
with details or without details. Both forms of the report list the following 
information. 
 

• Hour and visit totals for volunteers in each organization  
• Age and gender statistics for volunteers in each organization  
• Volunteer totals and statistics for all organizations listed in the report 

 
The with details report option lists each volunteer within each selected 
organization. It lists the volunteer's name, code, gender, age, organization codes, 
schedule codes, total visits, and total hours. The without details report displays 
totals only. In both forms of the report, when no hours have been recorded for a 
specified organization, that organization does not appear in the report.  
 
To display a Games Organization RS Hours report 
 
Select the Games type you want from the Select Games list box.  
Select the year for the report from the Fiscal Year dropdown list.  
Select No or Yes for the Show Detail option. 
Highlight an organization in the Available Organizations box and click the Add 
button. The highlighted organization will appear in the Selected Organizations box. 
Repeat the step for each organization you wish to include. 
To select all listed organizations, click the Add All button.  
To remove organizations that you have selected, highlight them in the Selected 
Organizations box and click the Remove button. 
To remove all selected organizations at once, click the Remove All button.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Service Assignment Schedule 
 
 
This screen lets you view the volunteers assigned to Games services. For each 
service listed the report shows the names, pseudo codes, and workday code for the 
volunteers. 
 
To display a Service Assignment Schedule 
 
Highlight the desired Game in the Select Game box.  
Highlight a service in the Available Services box. Click the Add button. The 
highlighted service will appear in the Selected Services box. Repeat this step for 
each service in the list you wish to print. 
To select all listed services, click the Add All button.  
If you wish to remove services that you have selected, highlight them in the 
Selected Services box and click the Remove button.  
If you wish to remove all selected services at once, click the Remove All button. 
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Service Regular Scheduled Hours 
 
 
Using this screen, you can display a report listing data on Games volunteers and 
their hours of service for specified Games services. The report may be printed with 
details or without details. Both forms of the report list the following information. 
 

• Hour and visit totals for volunteers in each service  
• Age and gender statistics for volunteers in each service  
• Volunteer totals and statistics for all services listed in the report 

 
The with details report option lists each volunteer within each selected service. It 
lists the volunteer's name, code, gender, age, service codes, schedule codes, total 
visits, and total hours. The without details report displays totals only. In both forms 
of the report, when no hours have been recorded for a specified service, that service 
does not appear in the report.  
 
To display a Games Service RS Hours report 
 
Select the Games type you want from the Select Games list box.  
Select the year for the report from the Fiscal Year dropdown list.  
Select No or Yes for the Show Detail option. 
Highlight a service in the Available Services box and click the Add button. The 
highlighted service will appear in the Selected Service box. Repeat this step for each 
service as needed. 
To select all listed services, click the Add All button.  
To remove services that you have selected, highlight them in the Selected Service 
box and click the Remove button.  
To remove all selected services at once, click the Remove All button.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Shirt Issue List 
 
 
This screen lets you print a report which can be used to issue Games shirts to 
volunteers. The report lists the volunteer names in alphabetical order, along with 
pseudo codes, shirt sizes, and spaces for signatures. The list provides a record of 
volunteers who have received their shirts and those who have not. The shirt sizes 
are specified when the volunteers register.  
 
To print a Shirt Issue List 
 
Highlight the desired Game in the Select Game box.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Sign In Roster 
 
 
This screen lets you print a sign-in sheet for volunteers reporting for work. Under 
each selected day of the week it lists service, service code, all scheduled volunteers, 
their pseudo code, and workday code. It includes a space for volunteers to sign in 
and a box for the staff person to check off. 
 
The roster can be sorted by last name or service assignment. Last Name lists all 
volunteers (in alphabetical order) working on each workday. Service Assignment 
lists all services for each day of the week in service code order. The volunteers are 
then listed in alphabetical order under each service.  
 
To display a Sign-In Roster 
 
Highlight the desired Game in the Select Game box.  
Check one or more Select Days check boxes to choose which days will be included on 
the roster. 
Select a Sort By radio button.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use.  
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Games 
Games Reports 

Telephone List (Games) 
 
 
This screen lets you print a telephone list for all Games volunteers. The telephone 
list includes the pseudo code and telephone number(s) for each volunteer. 
 
To print a games Telephone List 
 
Highlight the desired Game in the Select Game box.  
Choose a Print Format. 
Click the Display button. The report will appear in a browser window.  
 
Using the browser File menu, select Print to print the report. Select Save As to save 
the report to your hard drive for future use. 
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Games 
Games Service Codes 

 
 
This screen allows you to add or edit Games service codes. Each Games type has its 
own codes. 
 
When you create a new code, the system automatically supplies the next number, 
though you can enter a different number if it is not in use. The system 
automatically adds a letter after the code as listed below.  
 
W - Wheel Chair Games 
C - Creative Arts Festival 
G - Golden Age Games 
S - Winter Sports Clinic  
 
After the new code is posted, it becomes available for volunteers to use in their 
Games combination codes. The screen only lists the Games service codes for the host 
location. 
 
To create a new Games service code 
 
Click the New button.  
A new service code number appears in the Service Code field. However, you can 
enter a different unique number if you wish. The code must be three digits within 
the range of 600 to 699. 
Enter the name of the service (up to 22 characters) in the Name of Service field.  
Enter an abbreviation for the service (up to seven characters) in the Abbreviation 
field. (Optional)  
Enter another, optional identifier (up to 12 characters) in the Subdivision field.  
Click Post. "Record Posted!" displays at the top of the screen.  
 
To edit an existing Games service code 
 
Select the service code you wish to change from the Edit an existing Service Code 
dropdown list.  
Click Edit. Information for the selected service populates the screen's fields.  
Edit the fields as needed.  
Click Post. "Record Posted!" displays at the top of the screen.  
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Games 
Registration 

 
 
This screen is used to register volunteers so that their hours can be logged to their 
regular stations and/or organizations. To register, the person must be a regular 
volunteer at a Voluntary Services or Games station. If an individual is already a 
volunteer at a Voluntary Services station, his or her hours are automatically logged 
to the Games host station. If the individual is not a regular volunteer, this screen 
can be used to add them as a regular volunteer to the Games site. 
 
This screen and its subscreens are also used to add or edit a combination code for a 
previously registered volunteer (a single volunteer can have multiple combination 
codes) or remove a volunteer's registration. 
 
The service codes available for Games are national, not local. They are in the 600-
699 range, are specific to each particular Game type, and include service 
subdivisions. Organization codes for regular service volunteers are those used in 
their home station. The organization codes for non-regular service volunteers (those 
volunteering only for the Games) are those from the hosting site. 
 
To restore the Current Registered Volunteers list to its original state, click the 
Reset button. If you want to page through the list, use the First, Last, Prev, and 
Next buttons at the bottom of the list. 
 
To register a new Games volunteer 
 
First search for the volunteer's name in the Current Registered Volunteers list to 
make sure he/she is not already registered. 
Choose the search criteria from the Search by dropdown list and fill in the “for” 
field. Click the Search button. The Current Registered Volunteers list will reappear 
with only the names that meet your search criteria. If the person's name does not 
appear in the list, the volunteer is not registered. Click the Add button at the 
bottom of the screen. The Games Registration screen appears.  
 
Now you need to search the national Voluntary Services database to see if the 
person is a volunteer. Enter the volunteer's name and SSN in the Name and Social 
Security Number fields. Click the Search for Existing Volunteer button.  
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Games 
Registration, cont. 

 
 
If the name does not appear in the list box 
 
Click the Add button to the right of the list box. The Add Volunteer screen will 
appear. 
Fill in the fields on the Add Volunteer screen. The fields with asterisks are 
required. 
Click Next at the bottom of the screen. The Next of Kin screen appears.  
Fill in the fields in the Next of Kin screen (this screen is optional). 
Click Finish. The Games Registration screen appears.  
Fill in the fields and check boxes at the top of the screen. The Shirt Size and 
Lodging (where the volunteer is staying) fields are required.  
In the Add/Edit Combination Codes section of the screen, create a combination code 
for the volunteer using the Organization, Schedule Workday, and Service dropdown 
lists.  
Click Post to enter the combination code into the database. You should see “Record 
Posted” at the top of the screen. The combination code information will appear in 
the Combination Codes for this Volunteer list at the bottom of the screen.  
Repeat the steps if you want to create another combination code for the same 
volunteer.  
Click Done to return to the first Games Registration screen.  
 
If the name does appear in the list box 
 
Highlight the volunteer's name and click the Choose button. The registration page 
with Add/Edit Combination codes appears.  
Use the Organizations, Schedule Workday, and Service dropdown lists to create a 
combination code for the volunteer.  
Click Post to enter the combination code into the database. You should see “Record 
Posted” at the top of the screen. The combination code information will appear in 
the Combination Codes for this Volunteer list at the bottom of the screen.  
Repeat the steps if you want to create another combination code for the same 
volunteer.  
Click Done to return to the first Games Registration screen.  
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Games 
Registration, cont. 

 
 
To add or edit a combination code for a registered volunteer 
 
Search for the volunteer's name in the Current Registered Volunteers list. 
Choose the search criteria from the Search by dropdown list and fill in the “for” 
field. Click the Search button. The Current Registered Volunteers list will reappear 
with only the names that meet your search criteria. 
Click the Edit button next to the desired volunteer’s name. The Add/Edit 
Combination Codes screen appears.  
If you want to edit an existing combination code for the volunteer, find the code in 
the Combination Codes list at the bottom of the screen and click Edit. Use the 
Organizations, Schedule Workday, and/or Service dropdown lists to change the 
combination code. If you want to inactivate this code, check the Inactive check box.  
If you want to create a new combination code for the volunteer use the 
Organizations, Schedule Workday, and Service dropdown lists to make a new 
combination code. 
Click the Post button. "Record Posted!" appears at the top of the screen. The new or 
edited combination code appears in the Combination Codes for this Volunteer list. 
Click Done to return to the first Games Registration screen.  
 
To remove a volunteer from the current registered volunteers list 
 
Search for the volunteer's name in the Current Registered Volunteers list. 
Choose the search criteria from the Search by dropdown list and fill in the “for” 
field. Click the Search button. The Current Registered Volunteers list will reappear 
with only the names that meet your search criteria. 
Find the volunteer's name in the list and click the Remove button. The volunteer's 
name is deleted from the list and the Games host station database.  
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Games 
Multiple Days Hours 

 
 
The Multiple Day Hours screen is used for recording the hours for a single volunteer 
on one or more days. The hours are automatically recorded to the volunteer's home 
station. Because volunteers can have multiple combination codes, you can post 
hours multiple times for a single day. However, you cannot post hours for any one 
code for the same volunteer more than once in one day.  
 
Once you have made an entry, it appears in the Current Time Sheets list. This list 
shows all entries (time sheets) made for the volunteer during the Games. If you 
need to revise the hours or combination code listed for a time sheet, you can edit the 
time sheet and repost it, or delete it altogether. If you cannot find a volunteer 
among those currently registered, use the Registration screen to add them to the 
database.  
 
Volunteers who are VA employees will be noted as either "authorized absence" or 
"annual leave." If they are on authorized absence, the first 8 hours of work on any 
day should not count as volunteer hours. If they are on annual leave, all of their 
hours can count as volunteer hours. It is the responsibility of the person recording 
the hours to note if a volunteer is on authorized absence and post or edit the 
volunteer's hours accordingly. 
 
To post current day hours only for multiple volunteers, use the Single Day Hours 
screen. 
 
To post hours for a volunteer on one or more days 
 
Search for the volunteer's name in the Current Registered Volunteers list. 
Choose the search criteria from the Search by dropdown list and fill in the “for” 
field. Click the Search button. The Current Registered Volunteers list will reappear 
with only the names that meet your search criteria. If there are no names in the list 
you will need to add the volunteer to the database using the Registration screen.  
 
To restore the Current Registered Volunteers list to its original state, click the 
Reset button. If you want to page through the list, use the First, Last, Prev, and 
Next buttons. 
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Games 
Multiple Days Hours, cont. 

 
 
If the name does appear in the list, click the Select button next to the volunteer you 
wish to add hours for. A new screen appears.  
Accept the current date (default) or select a date from the Date dropdown list.  
Select a combination code from the dropdown list in the Combination Code field (list 
displays all the combination codes that have been assigned to the volunteer).  
Select the number of hours to record from the Hours dropdown list.  
Click the Post button. You will see "Record Posted" at the top of the screen and a 
new time sheet will appear in the Current Time Sheets list. 
Repeat the steps for each day that the volunteer has hours to record. You can also 
enter new hours for a different combination code for the same day.  
Click Exit to return to the Current Registered Volunteers list to select another 
volunteer.  
 
To edit a volunteer's previously recorded time 
 
Click the Select button next to the volunteer for whom you wish to edit time. A new 
screen appears.  
Click the Edit button to the left of the volunteer's desired time sheet in the Current 
Time Sheets table. The time sheet information will populate the Enter/Edit Time 
Sheet fields in the middle of the screen.  
Make the necessary corrections to the Combination Code and/or Hours fields.  
Click the Post button. The revised information will be added to the volunteer's 
record in the Current Time Sheets list.  
Click Exit to return to the Current Registered Volunteers list to select another 
volunteer.  
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Games 
Multiple Days Hours, cont. 

 
 
To delete a volunteer's previously recorded time 
 
Click the Select button next to the volunteer for whom you wish to delete time. A 
new screen appears.  
Click the Edit button to the left of the volunteer's time sheet in the Current Time 
Sheets list. The time sheet information will populate the Enter/Edit Time Sheet 
fields in the middle of the screen.  
Click the Delete button. The volunteer's time sheet will be deleted from the 
database.  
Click Exit to return to the Current Registered Volunteers list to select another 
volunteer.  
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Games 
Single Day Hours 

 
 
The Single Day Hours screen is used for recording volunteer hours for a single day. 
Its purpose is to quickly record hours for multiple volunteers for the current day. 
You can also post hours for multiple combination codes for a single volunteer. The 
hours are automatically recorded to the volunteer's home station.  
 
Once you have made an entry, it appears in the Current Time Sheets list. This list 
shows all entries (time sheets) made during the selected day. If you need to revise 
the hours or combination code listed for a time sheet, you can edit the time sheet 
and repost it, or delete it altogether. If you cannot find a volunteer among those 
currently registered, use the Registration screen to add them to the database.  
 
Volunteers who are VA employees will be noted as either "authorized absence" or 
"annual leave." If they are on authorized absence, the first 8 hours of work on any 
day do not count as volunteer hours. If they are on annual leave, all of their hours 
count as volunteer hours. It is the responsibility of the person recording the hours to 
note if a volunteer is on authorized absence and post or edit the volunteer's hours 
accordingly. 
 
To post multiple day hours for individual volunteers, use the Multiple Days Hours 
screen. 
 
To post hours for a volunteer for a single day 
 
Search for the volunteer's name in the Current Registered Volunteers list. 
Choose the search criteria from the Search by dropdown list and fill in the “for” 
field. Click the Search button. The Current Registered Volunteers list will reappear 
with only the names that meet your search criteria. If there are no names in the list 
you will need to add the volunteer to the database using the Registration screen.  
 
To restore the Current Registered Volunteers list to its original state, click the 
Reset button. If you want to page through the list, use the First, Last, Prev, and 
Next buttons at the bottom of the list. 
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Games 
Single Day Hours, cont. 

 
 
If the name does appear in the list, click the Select button next to the volunteer you 
wish to add hours for. A new screen appears.  
Accept the current date (default) or select the date from the Date dropdown list. The 
Current Time Sheets list at the bottom of the screen will display all the timesheets 
recorded on that date.  
Select a combination code from the dropdown list in the Combination Code field (list 
displays all the combination codes that have been assigned to the volunteer.) 
Select the number of hours to record from the Hours dropdown list.  
Click the Post button. You will see "Record Posted" at the top of the screen and a 
new time sheet will appear in the Current Time Sheets list.  
 
To add hours for the same volunteer for a different combination code 
 
Select a new combination code from the Combination Code dropdown list.  
Select the number of hours from the Hours dropdown list.  
Click Post.  
Click Exit to return to the Current Registered Volunteers list to select another 
volunteer.  
 
 
To edit a volunteer’s previously recorded time 
 
Click the Select button next to the volunteer whose hours you wish to edit. A new 
screen appears.  
In the Enter/Edit Form section, accept the current date (default) or select the date 
from the Date dropdown list.  
The Current Time Sheets list at the bottom of the screen will display all the 
timesheets recorded on that date.  
Click the Edit button to the left of the volunteer's desired time sheet in the Current 
Time Sheets table. The time sheet information will populate the Enter/Edit Form 
fields in the middle of the screen.  
Make the necessary corrections to the Combination Code and/or Hours fields.  
Click the Post button. The revised information will be added to the volunteer's 
record in the Current Time Sheets list.  
Click Exit to return to the Current Registered Volunteers list to select another 
volunteer.  
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Games 
Single Day Hours, cont. 

 
 
To delete a volunteer's previously recorded time 
 
Click the Select button next to the volunteer for whom you wish to delete time. A 
new screen appears.  
In the Enter/Edit Form section, accept the current date (default) or select the date 
from the Date dropdown list.  
The Current Time Sheets list at the bottom of the screen will display all the 
timesheets recorded on that date.  
Click the Edit button to the left of the volunteer's time sheet in the Current Time 
Sheets list. The time sheet information will populate the Enter/Edit Form fields in 
the middle of the screen.  
Click the Delete button. The volunteer's time sheet will be deleted from the 
database.  
Click Exit to return to the Current Registered Volunteers list to select another 
volunteer.  
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NEW/CHANGED FUNCTIONALITY FOR VERSION 3.06 
 
 
A new menu has been created called the Awards Menu that contains the options for 
Awards Management.  The options added to the menu are: 
 

Awards Coding 
Awards Processed Report 
Potential Awards Report 

 
The following is a list of the changes found in version 3.06.  Sites should run the 
options in the following order: first the Potential Awards Report to identify the 
volunteers eligible for an award; next the Awards Coding to actually code the 
awards identified by the Potential Awards Report; and finally the Awards Processed 
Report to show the volunteers that actually received an award (had an award coded 
in VSS). 
 
 
Potential Awards Report 
 
Before a site processes their awards, they should run the Potential Awards Report.  
This report will show all volunteers that are eligible for an award.  Version 3.06 
fixes the following problems with the report: 
 

Adults and Youths will no longer print on the same report 
The organization name will no longer double print 
The last volunteer name will no longer be dropped from each page 

 
This report has also been changed in version 3.06 to include the following 
enhancements: 
 

Ability to print mailing labels 
Moving Hours and Years award to the end of the report 
Changing the date of award to the last day of the month versus the first 
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Sites can choose to print labels from both the Potential Awards Report and the 
Awards Processed Report.  If a site chooses to print the labels from the Potential 
Awards Report, the labels will be printed prior to the award being processed in VSS 
(using the Award Coding option).  This also means that labels for the Hours and 
Years Award are also printed.  If a site chooses to print the labels from the Awards 
Processed Report, the labels will be printed after the award is processed in VSS.  
You cannot print the Hours and Years Award labels from the Awards Processed 
Report since this award is not processed in VSS.  Once awards have been processed 
in VSS, they will be removed from the Potential Awards Report and will show up 
under the Awards Processed Report. 
 
 
Award Processed Report 
 
The Awards Processed Report shows all awards coded within a date range.  If you 
select to code the awards on 9/30/03, you can run the Awards Processed Report for 
this date and see all the awards processed.  Version 3.06 fixes the problem with the 
sorting of the volunteer name on this report.  The volunteers are now sorted by last 
name. 
 
 
Awards Coding 
 
Be careful when using this option.  Once awards are processed they cannot be 
reversed. 
 
The Awards Coding option is the option to use to quickly process the awards for 
volunteers.  The same volunteers listed in the Potential Awards Report will appear 
on this option with the exception of the Hours and Years Award.  The Hours and 
Years Award is not processed in VSS.  Make sure the input parameters are equal to 
those used on the Potential Awards Report, especially the Date of Award. 
 
Version 3.06 fixes the following problems with the Awards Coding option: 
 

All object reference errors are resolved 
Adults and youths are no longer displayed in the same award  

 
The Awards Coding list and the Potential Awards Report will display the same data 
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This option has also been changed in version 3.06 to include the following 
enhancements: 
 

Name changed from Awards Management to Awards Coding 
Changing the date of award to the last day of the month versus the first 
Adding the input parameters on the Awards Coding screen 
Adding post and exit buttons to both the top and bottom of the screen 

 
 
Manual Coding of Awards 
 
A site may choose to manual code an award in VSS.  This can be done using the 
Station Profile option under Edit Volunteer (under the Volunteer Records Menu).  
Version 3.06 fixes the problem where an award could be coded with no award date; 
or, an award date could be entered with no award code.  This caused problems on 
the Potential Awards Report where a volunteer would show up with an award date 
and no award code.  These volunteers may still show up on the report in version 
3.06.  Sites can fix these by manual processing an award or by processing the award 
using the Award Coding option.  Once an award is processed for the volunteer using 
version 3.06, this problem will disappear. 
 
 
The following functionality change to version 3.06 is independent of 
awards. 
 
Volunteers By Organization VS26 Report 
 
The Volunteer By Organization VS26 Report has been fixed to correctly show the 
number of visits.  In order to see the count of visits, you must select Show Visits 
prior to hitting the Display button on the report interface. 
 
An enhancement to this report removes the age of the volunteer and replaces it with 
Youth or Adult. 
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NEW/CHANGED FUNCTIONALITY FOR VERSION 3.08 
 
 
Version 3.08 of the Voluntary Service System software contains enhancements for 
Donations and corrects some NOISs. 
 
1.  New Donation Menu 
A new menu has been created for Donations.  It contains all functionality for 
Donations except for the Donation Site Parameters. The Donation Site Parameters 
option can be found under the Maintenance Menu.  The following is the layout of 
the Donations Menu. 
 

Donations 
Reports 

Detail (Daily) 
Generate Memo 
Generate Receipt 
Grand Total of Donations 

Add/Edit Donation 
Search 

 
 
2.  Donation Search/Data View Option 
A new search option has been created to allow a site to search the database for 
donations within a specific set of parameters.  On the user interface, the user can 
select the following searchable parameters. 
 
Station 
Donation Date Range From and To 
Individual Example: SMI for smith, upper or lower case lookup 
Organization Example: Ame 
Local Branch Example: 132 
Other Groups Example: Fir 
Donation Type Check, Cash, Item, Activity, All 
Value Example: $100.00 
General Post Fund Example: 2213 
Check Number Example: 392 
Reference Example: Menlo 
In Memory Of Example: Ralph 
 
The Station and the Donation Date Range are the only mandatory fields for the 
search.  All other fields are optional and if left blank, or the default of All, then all 
donations will be returned. 
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The user is also given a list of all data elements stored within the donations 
package.  Using a checkbox, the user can select which data elements to display on 
the data view.  The data view will show the donations returned using the selected 
search criteria. 
 
The search results can be load into an Excel spreadsheet as follows. 
 

a. After displaying the results, from the browser window, click on Edit and  
 Select All. 
b. From the browser window, click on Edit and Copy. 
c. Start Excel with a new workbook open.  Click on Edit and Paste.  The result  
 set can now be used within Excel.  Sites can save the Excel spreadsheet on 
 their local hard drive. 

 
 
3.  Donation Site Parameters 
The Site Parameters option under the Maintenance Menu has been modified to 
allow sites to select specific donation site parameters.  Included in the site 
parameters are the following. 
 
GPF Accounts 
Alphanumeric up to 25 characters.  This is a site-specific General Post Fund 
account that the user can select when inputting a donation.  A site can have 
multiple General Post Fund accounts.  A GPF account can only be deleted if no 
donation values are applied to it.  A site can use the Donation Search/Data View to 
locate specific GPF accounts linked to individual donations. 
 
Voluntary Service Signature Line 
Type the name of the person signing donation letters.  This name will appear at the 
bottom of the letter.  Letters will be included in a future version. 
 
Director’s Signature Line 
Type the name of the Director signing donation letters.  If the parameter below (Set 
Value Amount for Director’s Signature) is entered, use the Director’s Signature Line 
instead of the Voluntary Service Signature Line on the donation letter.  Letters will 
be included in a future version. 
 
Set Value Amount for Director’s Signature 
If this value is entered and the donation amount exceeds this value, use the 
Director’s Signature Line on the donation letter instead of the Voluntary Signature 
Line.  Letters will be included in a future version. 
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VA Letter Head 
Yes or No selection.  If set to Yes, the VA Letter Head with the name and address of 
the facility will print at the top of the donation letters (see functionality below for 
the ability to add/edit the station’s address).  If set to No, the VA Letter Head will 
not print at the top of the donation letters.  Letters will be included in a future 
version. 
 
Reference: Alphanumeric up to 50 characters 
This is a site specific Reference that the user can select when inputting a donation; 
for example, Palo Alto where they would like to search donations by clinic.  Using 
this field, they can enter their clinics and link the donation to a specific clinic.  A 
site can have multiple References.  A Reference can only be deleted if no donations 
are assigned to it.  A site can use the Donation Search/Data View to locate specific 
References linked to individual donations. 
 
 
4.  Grand Total of Donations Report 
A new report, Grand Total of Donations Report, has been added under the Detail 
(Daily) Menu.  The inputs for the report are: Station, Date Range From and To 
(both are month, day, and year), selectable Donor Type: (Organization, Individual, 
Other Groups, Individual & Organization, Individual & Other Groups, and All), 
Summary or Detailed Report (the Summary report will just show Subtotals and 
Grand Totals), Reference all or selected, and the Print Format.  If the Donor Type is 
Organization, the user can select the Organizations to print on the report.  The 
Reference is selected from the site parameters for the selected station.  If the Donor 
Type is Individual & Organization, the report is sorted by the Organization followed 
by the Individual.  If the Donor Type is Individual and Other Groups, the report is 
sorted by the Other Groups followed by the Individual.  Subtotals by Organization 
are included.  If the Donor Type is Organization, the report is sorted by 
Organization and then by date.   
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5.  Add/Edit Donation Changes 
The Add/Edit Donation option has been changed for this version.  The following is a 
list of the major changes. 
 
a.  General Post Fund Breakout 
Sites now have the functionality to apply a single donation value to multiple 
unlimited GPF accounts.  Sites can also select the generic GPF account named 
None.  A site can edit a donation and change the GPF account once it has been 
posted.  To remove a GPF account from a donation, a site should select the GPF 
account of None. 
 
b.  Five CC Fields Added 
Sites can enter five CC fields for a donation.  The CC fields will be used with letters 
in a future version. 
 
c.  Family Contact Field Added 
A family contact field has been added to the donation.  The family contact field will 
be used with letters in a future version. 
 
d.  Check Number Field Required 
The check number field is now required for a donation type of check. 
 
e.  Individual/Organization Type on Add/Edit Donation Problem 
If you selected the donation type of Individual and entered a name, and then 
changed the type to Organization, it printed the individual’s name (as an Individual 
versus Organization) on the Donation Memo.  To fix this, change the default 
donation type to none and force the user to select the type.  Once the type is 
selected, allow the user to enter the rest of the donation fields based on type.  Do 
not allow the user to change the type.  This is reported in NOIS PAL-0604-60145. 
 
f.  Required Fields on Add/Edit Donation Problem 
The following fields are required prior to entering a donation, but they do not have 
an asterisk next to them indicating they are required: organization, individual and 
organization, affiliate, and individual and affiliate.  This is reported in NOIS BAY-
0604-30148. 
 
g.  Change Order of Fields 
The display order of the fields and location on the screen have been changed in the 
user interface when entering or editing a donation. 
 
h.  Turn off Check Number 
If the Donation Type does not equal Check, turn off the Check Number and Check 
Date fields. 
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i.  Eliminate in Memory Of 
For Individual and Activity Donations, Eliminate In Memory Of. 
 
j.  Change Donor Types 
Change the Donor Type from Individual & Affiliate to Other Groups & Individual. 
Change the Donor Type Individual & Organization to Organization & Individual. 
Change the Donor Type from Affiliate to Other Groups. 
 
k.  Change Description Field to Remarks 
Change the word Description to Remarks. 
 
l.  Show ID Number of Donation Posted 
After posting a donation, show the user the ID number of the donation posted.  The 
ID number can be used by voluntary staff to track and follow up on the printing of 
letters. 
 
 
6.  Generate Donations Receipt Problem 
This version fixes the error that occurs when printing a donation receipt or memo.  
The error reads: Value either too large or too small for an INT 16.  This is reported 
in NOIS UNY-0604-10282. 
 
 
7.  Add/Edit Station Address 
This version provides the functionality to allow the VSS manager at the station to 
add or edit the address of a station.  It does not allow the VSS manager to change 
the name of the station.  Central Office manages the name of the stations.  
Functionality was added in V. 3.07 to allow Central Office to add/edit the station 
name.  The ability to change the address at the station will be allowed for any 
person that has access to the Station Edit option under the Maintenance Menu (in 
most cases the VSS manager). 
 
 
8.  Remove Age on VS28 Report and Fix Visit Count 
The age is removed from the VS28 report and is replaced with A for Adult or Y for 
Youth.  This version also fixes the problem with the visit count as reported in NOIS 
MIW-0704-41629. 
 
 
9.  Hours and Years Award Problem 
Sites can no longer manually post hours and years awards.  This is reported in 
NOIS MWV-0504-21125. 
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10.  Volunteers on Meal List Twice Problem 
A volunteer will no longer appear on the meal list two times.  This is reported in 
NOIS MAD-0304-41312. 
 
 
11.  Remove Volunteer from Meal List 
If a volunteer does not want lunch and they are removed from the maintenance 
screen, their name still appears on the Dietetics Meal List.  This is reported in 
TOG-1203-11691. 
 
 
12.  Daily Volunteer List Not Alphabetical 
The Daily Volunteer List does not always print alphabetically.  This is reported in 
NOIS DET-0604-41261. 
 
 
13.  Voluntary Service Directory Display Problem 
Under the Voluntary Service Directory, the Chief and VISN Liaison fields always 
display “NO” regardless of what is set in the database.  This is reported in NOIS 
TOG-0604-11701. 
 
 
14.  Orphan Hours 
There are currently hours in the hours table linked to a station where the volunteer 
does not have a Volunteer Station Profile set up for the station.  Most of the entries 
are from migration.  This problem causes some of the counts to be off (hours are 
correct).  There are currently over 300 volunteers that have this problem.  The 
solution to clean these up is by creating a Volunteer Station Profile for the hours 
and then terminating the volunteer. 
 
 
15.  Remove Merge from VSS Menu 
This version will remove the option for the Merge functionality.  Sites that have a 
need to merge volunteers should submit a NOIS. 
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16.  Annual Report Optimized 
The Annual Report has been rewritten in an attempt to increase the speed.  This is 
a known problem.  Several large sites have trouble with timeouts when they 
attempt to print the Annual Report (for example:  Bay Pines). 
 
 
17.  Address Labels Problem Selecting Volunteers 
This version fixes the problem that occurs when selecting 30-40 volunteers to print 
addresses.  An error will occur as identified in NOIS CHY-0903-52043.   
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